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Product features

PageWide 352dw

J6U57A, J6U57B, J6U57C,
J6U57D

Tray capacity (75 GSM or 20-lb
Bond paper)

Tray 1: 50 sheets
Tray 2: 500 sheets

Standard output bin: 300
sheets

Duplex speeds up to 21 ppm
for both color and black with
Professional quality

Up to 45 ppm in General Office
mode

Connectivity

802.3 LAN (10/100) Ethernet
port

Wireless

Embedded wireless
capability

802.11n 5GHz dual band
support

HP ePrint—send
documents to the product
email address for printing

Simplex speedsup to30pages e  Host USB Type A and Type B HP Wireless Direct support
per minute (ppm) for both color ports (back)
and black with Professional
quality
Environmental features
Feature Environmental benefit
Duplex printing Automatic duplex printing is available on all models of HP PageWide 352dw.

Duplex printing saves the environment and saves you money.

Print multiple pages per sheet

Save paper by printing two or more pages of a document side-by-side on one
sheet of paper. Access this feature through the printer driver.

Recycling

Reduce waste by using recycled paper.

Recycle cartridges by using the HP Planet Partners return process.

Energy savings

Sleep modes and timer options enable this product to quickly go into reduced
power states when not printing, thus saving energy.

Accessibility features

The product includes several features that aid users with limited vision, hearing, dexterity or strength.

e  Online user guide that is compatible with text screen-readers.

e  (artridges can be installed and removed using one hand.

e  Alldoors and covers can be opened using one hand.

Chapter 1 Product basics
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Product views

° Front view
° Back view

° Cartridge door view

Front view

©0 0 00

Label Description
1 Control panel
2 Cartridge door
3 Tray 1 extension
4 Tray 1
5 Power button
6 Tray 2 — default paper tray
7 Output bin
Back view

Label Description
1 Output bin stop
2 Ethernet connection port

ENWW
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Label Description
3 USB Type A and USB Type B ports
4 Power cord connection
5 Left door
6 Duplexer
Cartridge door view

Label Description

1 Cartridge slots

2 Product serial number and product number
3 Cartridge part numbers

Chapter 1 Product basics
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Power on and off

NOTICE: To prevent damage to the product, use only the power cord that is provided with the product.

° Turn the product on

° Manage power

° Turn the product off

Turn the product on

1. Connect the power cord that is provided with the product to the connection port on the back of the
product.

2. Connect the power cord to a wall outlet with an adequate voltage rating.

’L%y NOTE: Make sure that your power source is adequate for the product voltage rating. The product uses
either 100-240 Vac or 200-240 Vac and 50/60 Hz.

3. Press and release the power button on the front of the product.

Manage power

HP PageWide 352dw printers include power-management features that can help reduce power consumption
and save energy.

e  Sleep Mode puts the product in a reduced power-consumption state if it has been idle for a specific
length of time. You can set the length of time before the product enters Sleep Mode from the control
panel.

e  Schedule On/Off enables you to turn the product on or off automatically at days and time that you set
from the control panel. For example, you can set the product to turn off at 6 p.m. on Monday through
Friday.

Set the Sleep Mode time

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {}.

3. Touch Power Management, and then touch Sleep Mode.

4. Select one of the time-interval options.
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The product switches into a reduced power-consumption state when it has been idle for the amount of time
that you select.

Schedule the product to turn on or off
1. Onthe printer control panel, touch Setup > Printer Setup.
2. Touch Power Handling, and then touch Schedule Printer On/Off.

3. Select the Schedule On or Schedule Off options, and then select the day and time that you want to
schedule.

The product switches on or off at the time you select on the day you select.

Turn the product off

NOTICE: Do not turn off the product if a cartridge is missing. Damage to the product can result.

A Press and release the power button on the front of the product to turn off your HP PageWide 352dw
printer.

A warning message appears on the control panel if you attempt to turn the product off when one or
more cartridges are missing.

NOTICE: To prevent print-quality problems, turn off the product by using the power button on the front
only. Do not unplug the product, turn off the powerstrip, or use any other method.
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Use the control panel

° Control panel menu buttons

° Control panel menu navigation

° Control panel action buttons

° Control panel supply status

° Help features

[% NOTE: The small text on the control panel is not designed for prolonged viewing.

Control panel menu buttons

Buttons on the control panel of HP PageWide 352dw printers enable you to view and navigate menus on the
display screen.

(2

? \

[ |
@ (2]
Inl
i}
“ |

(5 0 e

1 ,m Home button.

Touch to view the control panel home screen.

2 " Help button.
L]

Touch to view the Help menu options.

3 @Tﬂ Wireless

Solid blue when the product is connected to a wireless network. Blinks when the product is searching for a
wireless connection. Off when the product is connected to a wired network, or by a USB cable.

4 EE‘ HP ePrint button. Press for access to HP Web Services features.
Touch to access HP web services features.

HP ePrint enables you to print from your computer, tablet, or smart phone by sending documents to the
product’s email address.

5 g Back button. Press to return to the previous menu or screen.
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Control panel menu navigation

Buttons on the control panel enable you to scroll through menus and select from options that appear on a
menu list.

29
@ A
= ———T

o

|
06

1 Menu list. Five menu items can appear on the display screen. Touch the OK button to choose the highlighted
item.

2 Menu title. Appears at the top of the menu list.

3 Up and down. Use these buttons to scroll through the menu list and highlight an item.

4 OK. Touch to select the highlighted item from the menu list.

5 Cancel. Touch to cancel a print job or other current process, or to choose a menu item that appears at the lower

left of the menu list.

Control panel action buttons

Sometimes the control panel displays a message asking you to cancel a process, like a print job, or to choose
between two options: for example, Cancel or Continue. The options appear at the bottom of the menu list on
the display screen.

Fa¥
v
T

®
>
|
L1 o

1 Cancel. Touch to cancel the current process, or to choose the option at the lower left of the menu list.

2 OK. Touch to choose the option that appears at the lower right of the menu list (for example, Continue).

Control panel supply status

You can check your HP PageWide cartridge levels from the printer control panel.
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1. Onthe printer control panel, on the home screen, touch Setup .
2. Select Tools.
3. Select Supply Status.

The control panel displays the cartridge level for each of the four color cartridges.

1 Cartridge levels. The bars indicate the yellow, magenta, cyan, and black cartridge levels.

Help features

HP PageWide 352dw printers have built-in help that is accessible from the control panel. Help features
include tips, important product information that you can view or print, and animations that show how to
perform tasks or solve problems.

To view these help features, touch 7 on the printer control panel.

° Printer information

° Help animations

Printer information
The Printer Status Report displays the following information about your HP PageWide 352dw printer:
e  Model name and number
e  Product serial number
e  Product Service ID
e  Current firmware version number

e  Usage, status, and settings information if you print the full product information and printer status
report pages.

View or print a Printer Status report
1. Onthe printer control panel, on the home screen, touch Setup .
2. Touch Print Reports.

3. Touch Printer Status Report.
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Help animations

The built-in help contains animations that show how to perform tasks or solve problems. To select and view
an available help animation:

1.  Onthe printer control panel, touch ?.
2. Touch How To Videos.

3. Select the animation that you want to play in the printer control panel display.

Quiet Mode

To minimize printer noise, use Quiet Mode. You can enable this mode from either the control panel or the HP
Embedded Web Server (EWS).

[%r NOTE: Quiet Mode slows the printer speed. If it hinders productivity, you can turn the mode off.

To turn Quiet Mode on or off from the control panel

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {}.

3. Touch Quiet Mode and turn it on or off.

To turn Quiet Mode on or off from the EWS
1. Open the EWS. For more information, see Open the EWS.
2. Click the Settings tab.
3. Inthe Preferences section, click Quiet Mode and turn it on or off.

4. Click Apply.
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Connect the product

° Connect the product to a computer or a network

° Use Wi-Fi Direct to connect a computer or device to the product

° Install HP printer software for a wireless product already on the network

e  Open the printer software (Windows)

° Manage network settings

11
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Connect the product to a computer or a network

To connect the product using a USB cable

You can use a USB cable to connect the product to a computer.

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that
is no longer than 2 m (6.5 ft).

NOTICE: Do not connect the USB cable until the installation software prompts you to connect it.

1. Quit all open programs on the computer.

2. Install the printer software from 123.hp.com/pagewide (recommended) or from the HP software CD
provided with the printer, and follow the onscreen instructions.

[:?’”f’ NOTE: If you are installing on a Mac, click About HP Easy Start to install the software.

3. When prompted, select the USB-Connect the printer to the computer using a USB cable option, and
then click the Next button.

A,

B NOTE: A dialog box displays a warning that Web Services (HP ePrint and print Apps) are unavailable
with a USB installation. Click Yes to proceed with the USB installation, or click No to cancel it.

4. When the software prompts you, connect the Type B end of the USB cable to the connection port (1) at
the rear of the product.

5. When the installation is complete, print a page from any program to make sure that the printing
software is correctly installed.

Chapter 2 Connect the product ENWW



To connect the product to a network

The product supports connection to either a wired or a wireless network.

Supported network protocols

HP PageWide 352dw products support the following network protocols.

e  TCP/IPv4 ° gSOAP

e IPv6 e SAND box

e DHCP, AutolP e LPD

° DHCP v6 ° Bootp, Bootp TCE improvement
e  HTTPserver, HTTP client e Netbios

e SMTP client for alerts e WINS

° SNMP v1 ° LLMNR

e  Open_ssllibrary o C(IFSvée

° Bonjour

Connect the product using a wired network
Use this procedure to install the product on a wired network using Windows.

1.  Connect the Ethernet cable to the product (1) and to the network. Turn the product on.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns
an IP address or host name for the product.

3. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

4.  Onthe control panel dashboard, touch ‘% to display the IP address. Touch Print Details to print a page
with the IP address.

Connect the product using a wireless network (wireless models only)
You can connect the product to a wireless network using one of the following methods.

° To connect the product to a wireless network using the Wireless Setup Wizard

° To connect the product to a wireless network using WPS

° To connect the product to a wireless network manually

ENWW Connect the product to a computer or a network 13



If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network
settings from your system administrator, or complete the following tasks.

Obtain the wireless network name or service set identifier (SSID).

Determine the security password or encryption key for the wireless network.

[%”f NOTE: Beforeinstalling the product software, make sure the product is not connected to the network using
an Ethernet cable.

To connect the product to a wireless network using the Wireless Setup Wizard

The Wireless Setup Wizard is the best method for installing the product on a wireless network.

1.

Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

On the control panel dashboard, touch {£}.

Touch Network Setup, and then touch Wireless Settings.
Touch Wireless Setup Wizard.

The product scans for available wireless networks and returns a list of network names (SSIDs). Select
the SSID for your wireless router from the list if it is available. If the SSID for your wireless router is not in
the list, touch Enter SSID. When prompted for the type of network security, select the option that your
wireless router uses. A keypad opens on the control panel display.

Do one of the following:
e If your wireless router uses WPA security, type the passphrase on the keypad.
e If your wireless router uses WEP security, type the key on the keypad.

Touch 0K, and wait while the product establishes a connection with the wireless router. Establishing the
wireless connection can take a few minutes.

To connect the product to a wireless network using WPS

14

Before you can connect your printer to a wireless network using WPS, make sure you have the following:

A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.

B NOTE: The printer supports only connections using 2.4GHz.

A computer connected to the wireless network that you intend to connect the printer to. Be sure you
have installed the HP printer software on the computer.

If you have a WPS router with a WPS push button, follow the Push Button method. If you are not certain your
router has a push button, follow the PIN method.
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Push Button method

1. Onthe control panel, press and hold (i} on the printer for more than three seconds to start WPS push
mode. The (4} indicator starts blinking.

2.  Press the WPS button on your router.

The product begins a timer for approximately two minutes while a wireless connection is established.

PIN method
1. Locate the WPS PIN.

a. Openthe control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

b.  Onthe control panel dashboard, touch {}.

€.  Touch Network Setup, and then touch Wireless Settings.
d. Touch Wi-Fi Protected Setup, and then touch PIN.

2. Onthe control panel, press and hold (i4}) on the printer for more than three seconds to start WPS push
mode. The (ig) indicator starts blinking.

3. Open the configuration utility or software for the wireless router or wireless access point, and then enter
the WPS PIN.

’L%y NOTE: For more information about using the configuration utility, see the documentation provided
with the router or wireless access point.

4. Wait for about two minutes. If the printer connects successfully, the E{TJ} indicator stops blinking but
remains lit.

To connect the product to a wireless network manually

During the first 120 minutes of product setup, or after resetting the product's network defaults (and without a
network cable attached to the product), the product's wireless radio will broadcast a wireless setup network
for the product.

The name of this network is “HP-Setup-xx-[product name]”.

E?'”f} NOTE: The “xx” in the network name is the last two characters of the product's MAC address. The product
name is HP PageWide 352dw .

1.  From a wireless enabled product, connect to the setup network for the device.

2. Openaweb browser while connected to this setup network, and open the HP Embedded Web Server
(EWS) using the following IP address.

e 192.168.223.1

3.  Find the Wireless Setup Wizard in the EWS and follow the instructions to manually connect the product.

EY NOTE: The product uses Automatic DHCP by default.
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Use Wi-Fi Direct to connect a computer or device to the product

With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable
device—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct
e  Make sure your computer or mobile device has the necessary software.

— If you are using a computer, make sure you have installed the printer software from 123.hp.com/
pagewide (recommended) or from the HP software CD provided with the printer.

If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and
then install the printer software. Select Wireless when prompted by the printer software for a
connection type.

— If you are using a mobile device, make sure you have installed a compatible printing app. For more
information about mobile printing, visit the HP Mobile Printing website.

e  Make sure Wi-Fi Direct for your printer is turned on.
e  Up to five computers and mobile devices can use the same Wi-Fi Direct connection.

e  Wi-FiDirect can be used while the printer is also connected either to a computer using a USB cable or to
a network using a wireless connection.

e  Wi-FiDirect cannot be used to connect a computer, mobile device, or printer to the Internet.

To turn on Wi-Fi Direct

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch [&.

3. Touch {}.

4. If the display shows that Wi-Fi Direct is off, touch Wi-Fi Direct and switch it on.

X TIP: You can also turn on Wi-Fi Direct from the EWS. For more information about using the EWS, see HP
Embedded Web Server.

To print from a wireless-capable mobile device

Make sure you have installed a compatible printing app on your mobile device. For more information, visit the
HP Maobile Printing website.

1.  Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation
provided with the mobile device.

[% NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3.  From the mobile device, connect to a new network. Use the process you normally use to connect to a
new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks
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4.

shown such as DIRECT-**-HP PageWide XXXX (where ** are the unique characters to identify your
printer and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

Print your document.

To print from a wireless-capable computer (Windows)

1.

2.

4.

5.

Make sure Wi-Fi Direct for your printer is turned on.

Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with
the computer.

r_ﬁ”f NOTE: If your computer does not support Wi-Fi, you are not able to use Wi-Fi Direct.

From the computer, connect to a new network. Use the process you normally use to connect to a new
wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown
such as DIRECT-**-HP PageWide XXXX (where ** are the unique characters to identify your printer and
XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

B NOTE: To find the password, touch [ (Wi-Fi Direct) on the home screen.

Proceed to step 5 if the printer has been installed and connected to the computer over a wireless
network. If the printer has been installed and connected to your computer with a USB cable, follow the
steps below to install the printer software using the HP Wi-Fi Direct connection.

a. Open the printer software. For more information, see Open the printer software (Windows).

b. Click Printer Setup & Software, and then select Connect a new printer.

¢. When the Connection Options software screen appears, select Wireless.
Select your HP printer software from the list of detected printers.

d. Follow the onscreen instructions.

Print your document.

To print from a wireless-capable computer (0S X)

ENWW

1.

2.

Make sure Wi-Fi Direct for your printer is turned on.
Turn on Wi-Fi on the computer.
For more information, see the documentation provided by Apple.

Click the Wi-Fiicon and choose the Wi-Fi Direct name, such as DIRECT-**-HP PageWide XXXX (where **
are the unique characters to identify your printer and XXXX is the printer model located on the printer).

If Wi-Fi Direct is turned on with security, enter the password when prompted.
Add the printer.
a. Open System Preferences.

b. Click Printers.

Use Wi-Fi Direct to connect a computer or device to the product
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¢.  Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed in the right column
beside the printer name), and click Add.

Install HP printer software for a wireless product already on the

network

If the product already has an IP address on a wireless network and you want to install product software on a
computer, complete the following steps.

1.

2.

Obtain the product IP (on the control panel dashboard, touch -%).

Install the printer software from 123.hp.com/pagewide (recommended) or from the HP software CD
provided with the printer.

Follow the onscreen instructions.

When prompted, select Wireless - Connect the printer to your wireless network and internet, and then
click Next .

From the list of available printers, select the printer that has the correct IP address.

Open the printer software (Windows)

Depending on your operating system, you can open the printer software as follows:

Windows 10: From the computer desktop, click Start, select All apps, click HP, click the folder for the
printer, and then select the icon with the printer's name.

Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer
name.

Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then select
the printer name.

Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

Manage network settings

View or change network settings

Set or change the product password

Manually configure TCP/IP parameters from the control panel

Link speed and duplex settings

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.
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1.  Obtain the product IP (on the control panel dashboard, touch ‘%).

2. Type the product IP address into the address bar of a web browser to open the HP Embedded Web
Server.

3.  Click the Network tab to obtain network information. You can change settings as needed.

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on a
network so unauthorized users cannot change the product settings.

1.  Obtain the product IP (on the control panel dashboard, touch ‘%).

2. Type the product IP address into the address bar of a web browser. Click the Settings tab, click Security,
and then click the Password Settings link.

r_ﬁ”f NOTE: If a password has previously been set, you are prompted to type the password. Type “admin”
for User Name along with the password, and then click Apply.

3. Typethe new password in the Password field and in the Confirm Password field.

4. At the bottom of the window, click Apply to save the password.

Manually configure TCP/IP parameters from the control panel

Use the control panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. Onthe control panel dashboard, touch {£}.

3. Touch Network Setup, and then touch Ethernet Settings.
4. Touch Advanced Settings, and then touch IP Settings.
5. Touch Manual, and then touch IP Address.
6. Using the numeric keypad, do the following:
e  Enter the IP address, and touch Done .
e  Enter the subnet mask, and touch Done .
e  Enter the default gateway, and touch Done.

7. Touch Apply.

Link speed and duplex settings

ENWwW

[%Hf NOTE: This information applies only to Ethernet (wired) networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings
might prevent the product from communicating with other network devices. If you need to make changes, use
the printer control panel.

Manage network settings 19



BF NOTE:

e  The setting must match with the network product to which you are connecting (a network hub, switch,
gateway, router, or computer).

e  Making changes to these settings causes the product to turn off and then on. Make changes only when
the product is idle.

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {C}.
3. Touch Network Setup, and then touch Ethernet Settings.

4. Touch Advanced Settings, and touch Link Speed.

5. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and communication
mode allowed on the network.

10-Full 10 Mbps, full-duplex operation
10-Half 10 Mbps, half-duplex operation
100-Full 100 Mbps, full-duplex operation
100-Half 100 Mbps, half-duplex operation
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Printer management and services

° HP Embedded Web Server

° Web Services

° Product security features

e  HP Printer Assistant in the printer software (Windows)

e  HP Utility (0S X)
° AirPrint™ (0S X)
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HP Embedded Web Server

About the EWS

About cookies

Open the EWS

Features

About the EWS

This product is equipped with the HP Embedded Web Server (EWS), which provides access to information
about product and network activities. EWS provides an environment in which Web programs may run, much in
the same way that an operating system, such as Windows, provides an environment for programs to run on a
computer. The output from these programs can then be displayed by a web browser.

The EWS resides on a hardware device (such as an HP printer) or in firmware, rather than as software that is
loaded on a network server.

The advantage of the EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you must
have a supported web browser on the computer. To gain access to the EWS, type the IP address for the
product in the address bar of the browser.

About cookies

The EWS places very small text files (cookies) on your hard drive when you are browsing. These files let the
EWS recognize your computer the next time you visit. For example, if you have configured the EWS language,
a cookie helps remember which language you have selected so that the next time you access the EWS, the
pages are displayed in that language. Though some cookies are cleared at the end of each session (such as
the cookie that stores the selected language), others (such as the cookie that stores customer-specific
preferences) are stored on the computer until you clear them manually.

i/ IMPORTANT: The cookies that the EWS stores on your computer are used only for saving settings on your
computer or for sharing information between the printer and the computer. These cookies are not sent to any
HP websites.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to
remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following features:
e  Starting where you left the application (especially useful when using setup wizards).

e  Remembering the EWS browser language setting.

e  Personalizing the EWS home page.

For information about how to change your privacy and cookie settings and how to view or delete cookies, see
the documentation available with your web browser.
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Open the EWS

To open the EWS, do one of the following:

In a supported web browser, type the product IP address into the address box. (To obtain the IP address,
on the control panel dashboard, touch .%_)

In the printer software, open the HP Printer Assistant and on the Print tab, click Printer Home Page
(EwS).

For more information, see Open the HP Printer Assistant.

In 0S X, use HP Utility or click System Preferences > Printers > HP PageWide 352dw > Options &
Supplies > General > Show Printer Webpage.

E?’”f} NOTE: If an error occurs while opening the EWS, confirm that the proxy settings are correct for your
network.

X¥ TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

Features

Home tab
Web Services tab
Network tab

Tools tab

Settings tab

[Z?’”r NOTE: Changing network settings in the EWS might disable some product or product software features.

Home tab

Use the Home tab to access frequently used items from the Web Services, Network, Tools, and Settings
tabs. The Home tab includes the following items.

[Z?’”r NOTE: Not all of the following items are visible by default. Use the Personalize button to show or hide the
items of your choice.

Item Description

Energy Save Settings Configure energy-saving features that switch the printer to Sleep Mode or turn the printer on or
off automatically

Web Services Enable or disable HP ePrint or print apps that allow you to print from email

Printer Update Check for new printer updates

Estimated Cartridge Levels Review cartridge level status

Network Summary View wired (802.3) status or wireless (802.11) status

Print Quality Toolbox Run maintenance tools to improve print quality

Wireless Setup Wizard Set up a wireless connection using the wizard

ENWwW

HP Embedded Web Server
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Item Description

Wi-Fi Direct Set up Wi-Fi Direct to print from a mobile device directly to the printer without connecting to a
wireless network

AirPrint Set up AirPrint™ for printing from Apple-supported products

Printer Information View information about the printer, such as product serial number, service ID, firmware version,
and total page count

Administrator Set up administrator control of printer features

Backup Back up the printer settings into a password-encrypted file
Firewall Configure the network firewall

Printer Reports Print the information pages about your printer

Usage Report Display usage counters for print jobs

[%’/r NOTE: Settings for this page are automatically saved in the web browser's cookies. If the web browser's
cookies are deleted, these settings are lost.

Web Services tab

Use the Web Services tab to configure and enable HP Web Services for this product. You must enable HP Web
Services to use the HP ePrint feature.

Network tab

Use the Network tab to configure and secure network settings for the product when it is connected to an IP-
based network. The Network tab does not appear if the product is connected to other types of networks.

Tools tab

Use the Tools tab to view or manage product utilities. The Tools tab includes the following items.

Item Description

Product Information e Printer Information: View information about the printer, such as product serial number,
service ID, firmware version, and total page count

o  (Cartridge Level Gauge: Review cartridge level status

o  (Cartridge Settings: Set the threshold at which the printer provides notifications that
cartridges are running low

Reports o  Usage Report: View the number of pages processed for printing
o  Printer Reports: Print various reports, such as font lists
o  EventLog: View the printer's last 50 error messages
° Job Log: View a list of the most recent jobs performed by the printer

e  Color Usage Job Log: View the number of pages printed in black-and-white/grayscale and
color for all jobs and for individual jobs
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Settings tab

Item

Description

Utilities

e  Bookmarking: Bookmark pages in the EWS

e Print Quality Toolbox: Run maintenance tools to improve the print quality of your
printouts

e  Asset Tracking: Assign an asset number/location to this device

Backup and Restore

o  Backup: Create a password-encrypted file that stores the printer's settings

o Restore: Restore the printer's settings using a backup file created by the EWS

Printer Restart

Power Cycle: Turn off and restart the printer

Printer Updates

Firmware Updates: Set up the printer to alert you of updates or to automatically install
updates

Use the Settings tab to set and maintain various options on your product including power management, date

and time, printing and paper settings, email alerts, factory defaults, and firewall settings.

Item

Description

Power Management

Set up the Energy Save mode to minimize the amount of power that the product consumes
when idle and to reduce wear on electronic components

Preferences Configure the default settings for general printer features such as date and time, language,
display, and anonymous usage information. You can also set the default values for specific
features such as manual feed, tray and paper management, image registration, ColorLok, and
Quiet Mode.

Security Configure settings to prevent unauthorized use of the printer or specific printer features. For

more information, see Security settings.

Email Alerts

Set the default values for the email server, alert destinations, and alert settings

Print Settings

Configure default settings for printing (such as font, print quality, duplexing, and black-and-
white or color printing)

Restore Defaults

Restore the factory defaults or the network settings

Firewall

Configure firewall settings such as rules, addresses, services, and other options

Web Services

What are Web Services?

Set Up Web Services

Use Web Services

Remove Web Services

What are Web Services?

ENWW

The printer offers innovative, web-enabled solutions that can help you quickly access the Internet, obtain
documents, and print them faster and with less hassle—and all without using a computer.

Web Services
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[%r NOTE: To use these web features, the printer must be connected to the Internet (either using an Ethernet
cable or wireless connection). You cannot use these web features if the printer is connected using a USB cable.

HP ePrint

HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime, from
any location. It's as simple as sending an email to the email address assigned to your printer when you enable
Web Services on the printer. No special drivers or software are needed. If you can send an email, you can print
from anywhere, using HP ePrint.

Bf NOTE:

e  You cansign up for an account at the HP Connected website (might not be available in all countries/
regions), and sign in to configure the ePrint settings.

e  After you sign up for an account at the HP Connected website, you can sign in to view your HP ePrint job
status, manage your HP ePrint printer queue, control who can use your printer's HP ePrint email address
to print, and get help for HP ePrint.

Print apps

e  Print apps allow you to easily locate and print preformatted web content, directly from your printer. You
can also store your documents digitally on the web.

e  Preformatted content designed specifically for your printer means no cut-off text and pictures and no
extra pages with only one line of text. On some printers, you can also choose paper and print quality
settings on the print preview screen.

Set Up Web Services

Before you set up Web Services, make sure your printer is connected to the Internet using either an Ethernet
or wireless connection.

To set up Web Services, use one of the following methods.

To set up Web Services using the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {C}.
3. Touch Web Services Setup.

4. Touch Accept to accept the Web Services terms of use and enable Web Services.

5. Onthe screen that appears, touch OK to allow the printer to automatically check for product updates.

[%”f NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the onscreen
instructions to set up a proxy server. If you do not have the proxy details, contact your network
administrator or the person who set up the network.
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6. If the Printer Update Options screen appears, touch Install Automatically (Recommended) or Alert When
Available.

7. When the printer is connected to the server, the printer prints an information page. Follow the
instructions on the information page to finish the setup.

To set up Web Services using the EWS
1. Openthe EWS. For more information, see Open the EWS.
2.  Click the Web Services tab.

3. Inthe Web Services Settings section, click Setup, click Continue, and follow the onscreen instructions
to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

[%f NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the onscreen
instructions to set up a proxy server. If you do not have the proxy details, contact your network
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the
instructions on the information page to finish the setup.

Use Web Services

° HP ePrint
° Print apps
HP ePrint

To use HP ePrint, do the following:
e  Be sure you have an Internet- and email-capable computer or mobile device.

e  Enable Web Services on the printer. For more information, see Set Up Web Services.

For more information about managing and configuring HP ePrint settings and to learn about the latest
features, visit HP Connected . This site might not be available in all countries/regions.

To print documents using HP ePrint
1. Onyour computer or mobile device, open your email application.
2. (Create a new email message, and then attach the file that you want to print.

3. Enter the HP ePrint email address in the “To” field, and then select the option to send the email
message.

r_ﬁ”f NOTE: Do not enter any additional email addresses in either the "To" or "Cc" fields. The HP ePrint
server does not accept print jobs if there are multiple email addresses.
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To find the HP ePrint email address

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {C}.

3. Touch Web Services Setup, and then touch Print Info Page. The printer prints an information page that
contains the printer code and instructions on how to customize the email address.

To turn off HP ePrint from the control panel

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. Onthe control panel dashboard, touch .

3. Touch £}, and then touch HP ePrint and turn it off,

To turn off HP ePrint in the EWS
1. Open the EWS. For more information, see Open the EWS.
2.  Click the Web Services tab.
3. Inthe Web Services Settings section, for HP ePrint, click Turn Off.

4. Inthe confirmation dialog box that appears, click Yes.

Print apps

Print apps allow you to easily locate and print preformatted web content, directly from your printer.
To use print apps

1. Onthe control panel, touch the Apps application folder.

2. Touch the print app you want to use.

For more information about an individual print app, visit the HP Connected website. This site might not be
available in all countries/regions.

To manage print apps

You can add, configure, or remove print apps, and set the order in which they appear on your printer control
panel display.

1. Onthe control panel, touch the Apps application folder.

2. Inthe display, touch the Manage icon and follow the onscreen instructions.

E¥ NOTE:  You can also manage your print apps at the HP Connected website.

Remove Web Services

Use the following instructions to remove Web Services.
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To remove Web Services using the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. Onthe control panel dashboard, touch [.

3. Touch -[:}, and then touch Remove Web Services and touch Yes.

To remove Web Services using the EWS
1.  Openthe EWS. For more information, see Open the EWS.
2.  Click the Web Services tab.
3. Inthe Web Services Settings section, click Remove Web Services.
4. Click Remove Web Services to confirm.

5.  Click Yes to remove Web Services from your printer.

Product security features

° Security statements

° Firewall

° Security settings

° Firmware updates

Security statements

This product supports security standards and protocols that help secure the product, protect information on
your network, and simplify monitoring and maintenance of the product.

For information about HP's secure imaging and printing solutions, visit the HP secure printing website. The
site provides links to white papers and FAQ documents about security features and may include information
about additional security features that are not contained in this document.

Firewall

The HP Embedded Web Server allows you to enable and configure product firewall rules, priorities, templates,
services, and policies. The firewall feature provides a network layer of security on both IPv4 and IPv6
networks. The firewall configuration capability gives you control over IP addresses that are allowed to access
the product. It also lets you set permissions and priorities for digital send, management, discovery, and print
services. All of this helps provide a more secure way of controlling access to the product.

The firewall feature also allows you to disable unused protocols and services. These protocol and services
settings can also be protected from being changed by setting the EWS admin password. These protocols and
services include the following.
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Protocol or service

Description

IPv4 and IPv6

To operate properly on a TCP/IP network, the product must be configured with valid TCP/IP
network configuration settings, such as an IP address that is valid for your network.

This product supports two versions of this protocol: version 4 (IPv4) and version 6 (IPv6). IPv4
and IPv6 can be enabled/disabled individually or simultaneously enabled.

Bonjour

Bonjour services are typically used on small networks for IP address and name resolution
where a conventional DNS server is not used. The Bonjour service can be enabled or disabled.

SNMP

SNMP (Simple Network Management Protocol) is used by network management applications
for product management. This product supports the SNMPv1 protocol on IP networks. This
product allows the ability to enable/disable SNMPv1.

WINS

If you have a Dynamic Host Configuration Protocol (DHCP) service on your network, the product
automatically obtains its IP address from that server and registers its name with any RFC 1001
and 1002-compliant dynamic name services as long as the Windows Internet Name Service
(WINS) server IP address has been specified.

The WINS server IP address configuration can be enable or disabled. If enabled, then the
primary and secondary WINS server can be specified.

SLP

Service Location Protocol (SLP) is an Internet standard network protocol that provides a
framework to allow network applications to discover the existence, location and configuration
of networked services in enterprise networks. This protocol can be enabled or disabled.

LPD

Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer
spooling services that may be installed on various TCP/IP systems. LPD can be enabled or
disabled.

LLMNR

Link-Local Multicast Name Resolution (LLMNR) is a protocol based on the Domain Name System
(DNS) packet format that allows both IPv4 and IPv6 hosts to perform name resolution for hosts
on the same local link. LLMNR can be enabled or disabled.

Port 9100

The product supports raw IP printing through TCP Port 9100. This HP-propriety TCP/IP port on
the product is the default port for printing and it is accessed by HP software. Port 9100 can be
enabled or disabled.

Web Services

The product supports the ability to enable or disable Microsoft Web Services Dynamic Discovery
(WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported
on the product. These web services can be enabled or disabled together or WS Discovery can be
enabled separately.

Internet Printing Protocol (IPP)

Internet Printing Protocol (IPP) is an Internet-standard protocol that allows you to print
documents and manage jobs over the internet. IPP can be disabled or enabled.

Security settings

On the Settings tab of the Embedded Web Server, under Security, you can find the following options.

Item

Description

Password Settings

Set a password to prevent unauthorized users from remotely configuring the printer or viewing
printer settings from the EWS

Administrator Settings

Customize your printer by enabling or disabling features related to network connectivity, Web
Services, printer functions (such as color printing), memory devices, and firmware updates

Control Panel Shortcuts

Select which shortcuts appear in the Shortcuts folder on the printer control panel

Access Control

Enable and configure sign-in methods to control user access to specific printer tasks

Protect Stored Data

Configure settings to protect jobs stored on the printer from unauthorized users
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Firmware updates

The printer firmware can be automatically updated. On the Tools tab of the Embedded Web Server, click
Printer Updates, Firmware Updates, and then Install updates automatically. HP recommends using this
option.

HP Printer Assistant in the printer software (Windows)

The HP Printer Assistant provides access to HP printer features and resources from the Windows programs
menu or the desktop icon on your computer.

Open the HP Printer Assistant
1. Onyour computer, click Start , and then click All Programs.

2.  Click HP, click the name of the product, and then click your printer.

Features

° Connected tab

° Print tab
° Shop tab
° Help tab

° Tools tab

° Estimated Levels tab

Connected tab

Click the Connected tab to access the HP Connected website (might not be available in all countries/regions).
HP Connected gives you a single login for select HP apps and cloud solutions plus access to the HP Connected
platform from a smartphone, tablet, computer, or web-enabled HP printer. You can sign into HP Connected
using your existing ePrintCenter account or sign up for a new HP Connected account.

Print tab

Use the Print tab to view or manage print utilities. This tab includes the following items.
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Item Description

Print o  Connect Printer to the Web: Click to open the HP website and get new content and solutions for
your HP web-connected printer

o  SetPreferences: Click to open your Printing Preferences dialog box to view and change defaults
for paper size, print quality, and more

e Maintain Your Printer: Click to open the Toolbox to align and clean cartridges or print a diagnostic
page

° Print From Your Mobile Devices: Click to open the HP Mobile Printing website to learn how to print
from your smartphone or tablet. If a local version of this website is not available in your country/
region, you might be directed to the HP Mobile Printing site in another country/region or language.

° See What's Printing: Click to open the print monitor and view, pause, or cancel your print jobs

o Customize Your Printer: Click to open your Printing Preferences dialog box to change the name,
security settings, or other properties of your printer

o  Printer Home Page (EWS): Click to open the HP Embedded Web Server to configure, monitor, and
maintain your printer

Shop tab

Use the Shop tab to shop for HP supplies and other products online.

Help tab

Use the Help tab to access resources such as online help and HP Eco Solutions.

Tools tab

Use the Tools tab to set and maintain the printer driver and software and to diagnose and resolve printing
and connectivity problems.

Estimated Levels tab

Use the Estimated Levels tab to review cartridge levels and to order new cartridges, if needed.

HP Utility (0S X)

HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find
website support information.

[%’/r NOTE: The features available in HP Utility vary depending on the selected printer.

Cartridge level warnings and indicators provide estimates for planning purposes only. When you receive
a low-cartridge warning message, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace cartridges until the print quality becomes unacceptable.

Open HP Utility
A Double-click HP Utility in the HP folder, in the Applications folder.
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AirPrint™ (0S X)

Your product supports printing with Apple’s AirPrint for i0S 4.2 and Mac 0S X v10.9 or later. Use AirPrint to
print wirelessly to the printer from an iPad (i0S 4.2), iPhone (3GS or later), or iPod touch (third generation or
later).

For more information, see Print with AirPrint (0S X).
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4 Paper and print media

° Understand paper use

° Supported media sizes

° Supported paper types and tray capacity

e  (Configure trays

° Load media

° Tips for selecting and using paper
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Understand paper use

HP PageWide cartridges for business are specifically developed for use with HP printheads. Unique
formulations help extend the life of the printheads and enhance reliability. When used with ColorLok® paper,
these cartridges provide laser-like color output that dries quickly and is ready for distribution.

ENWW

[% NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using papers with
the ColorLok® logo for this product. For details, visit the HP print permanence website.

This product supports a variety of paper and other print media. Paper or print media that does not meet the
following guidelines might cause poor print quality, increased jams, and premature wear on the product.

It is possible for paper to meet all of these guidelines and still not produce satisfactory results. This might be
the result of improper handling, unacceptable temperature and/or humidity levels, or other variables over
which HP has no control.

NOTICE:

Using paper or print media that does not meet HP specifications might cause problems for the

product, requiring repair. This repair is not covered by the HP warranty or service agreements.

Use the following guidelines to obtain satisfactory results when using special paper or print media. Set the

paper type and size in the printer driver to obtain the best results.

Media type Do Do not
Envelopes ° Store envelopes flat. Do not use envelopes that are wrinkled, nicked,
stuck together, or otherwise damaged.
e  Use envelopes where the seam extends all the way
to the corner of the envelope. Do not use envelopes that have clasps, snaps,
windows, or coated linings.
Labels o  Use fresh labels. Old labels are more likely to Do not use labels that have wrinkles or bubbles, or

delaminate during printing.

Use only labels that have no exposed backing
between them.

Use labels that lie flat.

Use only full sheets of labels.

are damaged.

Do not print partial sheets of labels.

Letterhead or
preprinted forms

Use only letterhead or forms approved for use in
HP PageWide products.

Do not use raised or metallic letterhead.

Heavy paper e  Use only heavy paper that is approved for use in Do not use paper that is heavier than the
HP PageWide products and meets the weight recommended media specification for this product
specifications for this product. unless it is HP paper that has been approved for
use in this product.
Glossy or coated e  Use only glossy or coated paper that is approved Do not use glossy or coated paper designed for
paper for use in HP PageWide products. use in laser products.
NOTICE: Do not use any media that contains staples or paper clips.

Understand paper use
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Supported media sizes

For best results, use the appropriate paper and media sizes:

Supported paper and print media sizes

Supported envelope sizes

Supported card and label sizes

Supported photo media sizes

Supported paper and print media sizes

Electronic duplex

Size Dimensions Tray 1 Tray 2 printing
Letter 216 x 279 mm (8.5 x 11 inches) - - "
Oficio 8.5x 13 (8.5 x 13 inches) - "
Oficio 216x340 mm 216 x 340 mm L v
Legal 216 x 356 mm (8.5 x 14 inches) v v
A4 210x297 mm (8.3 x 11.7 inches)  w~ - v
Executive 184 x 267 mm (7.25x 10.5 w w v
inches)
Statement 140 by 216 mm (5.5 x 8.5 inches) v
A5 148 x 210 mm (5.8 x 8.3 inches) s s
A6 105x 148.5mm (4.13 x5.83 v
inches)
B5 (JIS) 182x257 mm (7.17 x 10.12 - - "
inches)
B6 (JIS) 128x182 mm (5 x 7 inches) -
16k 184 x 260 mm (7.24 x 10.23
. - "
inches)
195x270 mm (7.68 x 10.62
. - w
inches)
197 x273 mm (7.75x 10.75
. - v
inches)
Custom Minimum: 76 x 127 mm (3 x 5 Width: 76 to 216 mm Width: 102 to 216 mm

inches)

Maximum: 216 x 356 mm (8.5 x
14 inches)

(3 to 8.5 inches)

Length: 127 to 356
mm (5 to 14 inches)

(4 to 8.5 inches)

Length: 210.06 to
297.2 mm (8.27 to
11.7 inches)
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Supported envelope sizes

Size Dimensions Tray 1 Tray 2
Envelope #10 105 x 241 mm (4.13 x 9.49 inches) - w
Envelope DL 110 x 220 mm (4.33 x 8.66 inches) - -
Envelope C5 162 x 229 mm (6.4 x 9 inches) - -
Envelope B5 176 x 250 mm (6.7 x 9.8 inches) - "
Envelope (6 114 x 162 mm (4.5 x 6.4 inches) [

Monarch 98.4 x 190.5 mm (3.875 x 7.5 inches) -

Japanese Envelope Chou #3 120 x 235 mm (4.7 x 9.3 inches) -

Japanese Envelope Chou #4 90 x 205 mm (3.5 x 8.1 inches) w

Supported card and label sizes

Size Dimensions Tray 1 Tray 2
3x5 (76.2 x 127 mm) (3 x 5 inches) -

4x6 (102 x 152 mm) (4 x 6 inches) -

5x8 (127 x 203 mm) (5 x 8 inches) -

A6 (105 x 148.5 mm) (4.13 x 5.83 inches) -

Double Japan Postcard Rotated (148 x 200 mm) (5.8 x 7.9 inches) v

Labels (Letter and A4) v w

Supported photo media sizes

Size Dimensions Tray 1 Tray 2
4x6 (102 x 152 mm) (4 x 6 inches) -

10x15cm (100 x 150 mm) (3.9 x 5.9 inches) -

L (89 x 127 mm) (3.5 x 5 inches) w

5x7 Photo Media (5 x 7 in no-tabs) (127 x 178 mm) (5 x 7 inches) w

Photo Media (Letter & Ad) v w
Japanese Postcard (100 x 148 mm) (3.9 x 5.8 inches) v

Custom

Minimum: 76 x 127 mm (3 x 5 inches)

Maximum: 216 x 356 mm (8.5 to 14 inches)

Width: 76 to 216 mm Width: 102 to 216 mm
(4 to 8.5 inches)

(3 to 8.5 inches)

Length: 127 to 356 Length: 210.06 to
mm (5 to 14 inches) 297.2 mm (8.27 to

11.7 inches)

ENWW

Supported media sizes
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Supported paper types and tray capacity

For best results, use the appropriate paper types and tray capacities:

e  Tray 1 (multipurpose) on left side of the product

e  Tray 2 (default tray)

Tray 1 (multipurpose) on left side of the product

Paper type Weight Capacity’

Paper orientation

Every day: 60 to 175 g/m? (16 to 47 lb) Up to 50 sheets
e  Unspecified and Plain

e HP EcoFFICIENT

o  Letterhead

e  Preprinted

o  Prepunched

o  Light 60-74g

e  Intermediate 85-95g

e  Mid-Weight 96-110g

e  Heavy111-130g

e  HP Premium Presentation Matte 120g

° Extra Heavy 131-175g

Side to be printed on face-
down, with the top edge
toward the printer

o HP Brochure Matte 180g Up to 220 g/m? (58 Ib)’ Up to 25 sheets
e HP Brochure Glossy 180g

e  (Cardstock 176-220g

e  HP Cover Matte 200g

e  HP Advanced Photo Papers

Side to be printed on face-
down

e  Envelope Up to 7 envelopes or labels
e Heavy Envelope

e Labels

Side to be printed on face-
down

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.
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Tray 2 (default tray)

Paper type Weight Capacity' Paper orientation

e  Unspecified and Plain 60 to 175 g/m? (16 to 47 Ib) Up to 500 sheets Side to be printed on face-up,
with the top edge toward the

] HP EcoFFICIENT left

° Letterhead

° Preprinted

e  Prepunched

e Light 60-74g

Intermediate 85-95g

Mid-Weight 96-110g

Heavy 111-130g

HP Premium Presentation Matte 120g

Extra Heavy 131-175g

HP Brochure Matte 180g Up to 220 g/m? (58 Lb) Up to 100 sheets Side to be printed on face-up
HP Brochure Glossy 180g

Cardstock 176-220g

HP Cover Matte 200g

HP Advanced Photo Papers

Envelope Up to 30 envelopes or labels. Side to be printed on face-up

Heavy Envelope NOTE: Tray 3 does not
support envelope printing.
Labels

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.

Configure trays

By default, the product pulls paper from Tray 2. If Tray 2 is empty, the product pulls paper from Tray 1.

[%”f NOTE: If you change the default tray to Tray 1, be sure to configure the tray for the correct paper size and
type.

If you use special paper for all or most print jobs on the product, change this default tray setting on the
product.

The following table lists possible ways you can use the tray settings to meet your printing needs.

ENWW Configure trays
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Paper use

Configure the product

Print

Load Tray 1 and one other tray with the
same paper, and have the product pick
paper from one tray if the other one is
empty.

Load paper in Tray 1, and configure the
tray for the correct paper and type. Do not
use Any Size/Any Type.

From the software program, print the job.

Frequently use special paper, such as

heavy paper or letterhead, from one tray.

Load special paper in Tray 1, and configure
the tray for the paper type.

From the software program print dialog,
choose the paper type that matches the
special paper loaded in the tray before
sending the print job. Select Tray 1 as the
Paper Source from the Paper/Quality tab
(Windows) or Paper Feed pop-up menu (0S
X).

Load media

° Load Tray 1
° Load Tray 2

° Load envelopes

° Load letterhead or preprinted forms

Load Tray 1

40

Tray 1 is the multipurpose tray at the left side of the product.

[f_%f NOTE: If you are not using Alternate Letterhead Mode (ALM), place the paper with the side to be printed on
face-down, with the top edge toward the printer. For ALM orientation, see Load letterhead or preprinted

forms .

1. OpenTray1.

2.

Chapter 4 Paper and print media
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3. Open the paper guides completely, and then load the paper stack into Tray 1.

4.

Load Tray 2

Tray 2 is the default (main) paper tray at the front of the product.

@ NOTE: If you are not using Alternate Letterhead Mode (ALM), place the paper with the side to be printed on
face-up, with the top edge toward the left side of the tray. For ALM orientation, see Load letterhead or
preprinted forms .

1.  Pull the tray out of the product.

2. Open the paper length and width guides completely.
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3. Place the paper in the tray and make sure that it is flat at all four corners. Close the length and width
paper guides against the loaded media.

4. Push down on the paper to make sure that the stack is below the paper limit tabs on the side of the tray.

5.  Put the tray into the product.

Load envelopes

You can load envelopes into Tray 1 or Tray 2.

To load envelopes into Tray 1

1. OpenTray1.
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2. Pull out the Tray 1 extension.

3. Place envelopes in Tray 1 face-down, with the top of the envelope oriented toward the front of the
printer.

4. Close the paper guides.

To load envelopes into Tray 2

1. Pull the tray out of the product.

2.

3. Place the envelopes in the tray and make sure that they are flat at all four corners. Close the length and
width paper guides against the loaded media.
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4.  Push down on the envelopes to make sure that the envelopes are below the paper limit tabs on the side
of the tray.

5.  Put the tray into the product.

Load letterhead or preprinted forms

You can load letterhead, preprinted, or prepunched forms into any tray. Paper orientation depends on
whether you are printing in simplex or duplex mode. If Alternative Letterhead Mode (ALM) is enabled, you can
print in both simplex and duplex modes without reorienting the paper.

[%'/]’9 NOTE: With ALM enabled, you must select Letterhead, Preprinted, or Prepunched as the paper type in the
Printer Properties dialog box.

To enable or disable ALM from the control panel

1. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {C}.
3. Touch Tray and Paper Management, and then touch Alternative Letterhead Mode and turn it on or off.

To enable or disable ALM from the EWS

1.  Type the product IP address into the address box of a web browser to open the EWS. (To obtain the
product IP, on the control panel dashboard, touch .%_)

2.  Click the Settings tab.
3. Click Preferences, and then click Tray and Paper Management.
4. Inthe Alternative Letterhead Mode section, select Enabled or Disabled.

5. Click Apply.

To load letterhead or preprinted forms with ALM enabled

1. Depending on the tray, orient the paper as follows.

Tray 1 Other tray(s)

Place the letterhead face-up, with the top of the page oriented  Place the letterhead face-down, with the top of the page
toward the left. oriented toward the right.

2. Complete the stepsin Load Tray 1 or Load Tray 2.
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To load letterhead or preprinted forms with ALM disabled

1. Depending on the tray, orient the paper as follows.

Tray 1

Other tray(s)

Simplex Place the letterhead face-down, with the top of
the page oriented toward the right.

Place the letterhead face-up, with the top of the
page oriented toward the left.

Duplex Place the letterhead face-up, with the top of the
page oriented toward the left.

Place the letterhead face-down, with the top of
the page oriented toward the right.

2. Complete the stepsin Load Tray 1 or Load Tray 2.

ENWW

Load media
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Tips for selecting and using paper

For the best results, observe the following guidelines.

e  Load only one type of paper at a time into the tray.

e  Make sure the paper is loaded correctly when loading from the tray.
e Do not overload the tray.

e  To prevent jams, poor print quality, and other printing problems, avoid loading the following paper in the
tray:

— Multipart forms

— Media that is damaged, curled, or wrinkled

— Media with cutouts or perforations

— Media that is heavily textured, embossed, or otherwise difficult to print on
— Media that is too lightweight or stretches easily

— Media that contains staples or clips
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° HP PageWide cartridges

° Manage cartridges

° Replace cartridges
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HP PageWide cartridges

HP policy on non-HP cartridges

% IMPORTANT:
e  HP does not guarantee the quality or reliability of non-HP contents in HP cartridges.
e  HP’s cartridge warranty does not cover non-HP cartridges or cartridges with non-HP contents.

e  HP’s printer warranty does not cover repairs or service due to use of non-HP cartridges or cartridges
with non-HP contents.

By NOTE:

e  This printer is not designed to use continuous ink systems. To resume printing, remove the continuous
ink system and install original HP (or compatible) cartridges.

e  This printer is designed for cartridges to be used until they are empty. Refilling cartridges before they
are depleted might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP
or compatible) to continue printing.

Counterfeit HP cartridges
Your cartridge might not be a genuine HP cartridge if you notice the following:
e  The control panel or printer status report indicates that a used or counterfeit cartridge is installed.
e  You are experiencing a high number of problems with the cartridge.
e  The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).

Visit the HP anticounterfeit website when you install an HP print cartridge and the control panel message
says the cartridge is used or counterfeit. HP will help resolve the problem.

Manage cartridges

Correctly storing, using, and monitoring cartridges can help ensure high-quality print output and extend the
life of cartridges.

° Store cartridges

° Print with General Office mode

° Print when a cartridge is at estimated end of life

° Check the estimated cartridge levels

° Order cartridges

° Recycle cartridges
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Store cartridges
e Do not remove the cartridge from its package until you are ready to use it.

e  Store cartridges at room temperature (15-35° C or 59-95° F) for at least 12 hours before using them.

e  Handle cartridges carefully. Dropping, jarring, or rough handling during installation can cause temporary

printing problems.

Print with General Office mode
General Office mode produces slightly lighter printouts, which might extend the life of the cartridge.
1. Onthe File menu in the software program, click Print.
2.  Make sure your printer is selected.
3.  Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options,
Printer Setup, Printer Properties, Printer, or Set Preferences.

Do one of the following.

e  Windows: Click Print Options, and then click Properties.

e  0S X: From the pop-up menu, select Copies and Pages.
4. Click the Paper/Quality tab.

5. Select General Office from the Print Quality drop-down list (Windows) or pop-up menu (0S X).

Print when a cartridge is at estimated end of life

Supply-related notifications are communicated on the printer control panel.

e  (artridge Low message appears when a cartridge is nearing the estimated end of its useful life. Printing

can continue, but consider having a replacement cartridge available.

e  C(artridge Very Low message appears when the cartridge is near its estimated end of useful life. Have a
replacement cartridge available.

e  (artridge Depleted message appears when the cartridge is empty.

[:?’”f NOTE: Although using the Continue setting allows printing beyond Cartridge Very Low without replacing
the cartridge, the product will shut down before any print problems occur.

Check the estimated cartridge levels
You can check the estimated cartridge levels from the printer control panel or from the printer software.

To check the cartridge levels from the control panel

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. Onthe control panel dashboard, touch ‘. to display the estimated cartridge levels.

ENWW Manage cartridges
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To check the cartridge levels from the EWS
1. Open the EWS. For more information, see Open the EWS.

2. Click the Tools tab, and then click Cartridge Level Gauge.

To check the cartridge levels from the product software (Windows)

1.  Open the HP Printer Assistant. For more information, see Open the HP Printer Assistant.

2. Onthe Print tab, click Maintain Your Printer.

3.  Click the Estimated Cartridge Levels tab.

To check the cartridge levels from the product software (0S X)
1.  Open HP Utility. For more information, see Open HP Utility.
2.  Make sure your printer is selected.
3.  Click Supplies Status.
The estimated cartridge levels appear.

4.  Click All Settings to return to the Information and Support pane.
B NOTE:

e If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another
printer, the cartridge level indicator might be inaccurate or unavailable.

e  C(artridge-level alerts and indicators provide estimates for planning purposes only. When you receive
a low-cartridge alert, consider having a replacement cartridge available to avoid possible printing
delays. You do not need to replace the cartridges until you are prompted to.

e Ink from the cartridges is used in the printing process in a number of different ways, including in the
initialization process, which prepares the printer and cartridges for printing, and in printhead servicing,
which keeps the cartridges printing smoothly. Some residual ink is left in the cartridge after it is used.
For more information, visit the HP SureSupply website.

Order cartridges

To order cartridges, visit the HP website . (At this time, some portions of the HP website are available in
English only.) Ordering cartridges online is not supported in all countries/regions. However, many countries
have information on ordering by telephone, locating a local store, and printing a shopping list. In addition, you
can visit the HP SureSupply website to obtain information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the cartridge you are replacing.
You can find the cartridge number in the following places:

e  Onthe label of the cartridge you are replacing.
° On a sticker inside the printer. Open the cartridge access door to locate the sticker.

e Inthe printer software, open the HP Printer Assistant, click Shop, and then click Shop For Supplies
Online.

° In the HP Embedded Web Server, click the Tools tab and then, under Product Information, click
Cartridge Level Gauge. For more information, see HP Embedded Web Server.
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[% NOTE: The SETUP cartridge that comes with the printer is not available for separate purchase.

Recycle cartridges

Visit the HP sustainability website for full information on recycling and to order postage-paid labels,
envelopes, and boxes for recycling.

Replace cartridges

The product uses four colors and has a different cartridge for each color: yellow (Y), magenta (M), cyan (C),
and black (K).

NOTICE:

To prevent print-quality problems, HP recommends replacing any missing cartridges with genuine HP
cartridges as soon as possible. For more information, see Order cartridges.

Never turn off the printer if any cartridges are missing.

1.

2.

3.

ENWW

Open the cartridge door.

Push the old cartridge inward to unlock and release it.

Grasp the edge of the old cartridge and then pull the cartridge straight out to remove it.

e >

Replace cartridges
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4. Do not touch the metal contacts on the cartridge. Fingerprints on the contacts can cause connection
errors.

5. Insert the new cartridge into its slot.

6.
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Tips for working with cartridges

Use the following tips to work with cartridges:
e  To prevent print-quality problems, do the following:

— Always turn the printer off using the power button on the front, and wait until the power button
light goes out.

—  Make sure that all the cartridge slots are filled.
e |f youremove a cartridge from the printer for any reason, try to replace it again as soon as possible.
e Do not open or unpackage cartridges until you are ready to install them.

e Insert the cartridges into the correct slots. Match the color and icon of each cartridge to the color and
icon for each slot. Make sure the cartridges snap into place.

e  When the Estimated Cartridge Levels screen shows one or more cartridges in a low state, consider
getting replacement cartridges to avoid possible printing delays. You do not need to replace the
cartridges until prompted to. See Replace cartridges for more information.

e Do not clean the printhead unnecessarily. This shortens the life of the cartridges.

e If you are transporting the printer, do the following to prevent leaking from the printer or other damage
from occurring.

— Make sure you turn off the printer by pressing the power button in the front. Wait until all sounds
of internal motion stop before unplugging the printer.

— Make sure you leave the cartridges installed.

— The printer must be transported sitting flat; it should not be placed onits side, back, front, or top.
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6 Print

° Print from a computer

° Print with HP ePrint

e  Print with AirPrint (0S X)

° Tips for print success
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Print from a computer

To print from a computer (Windows)

These instructions apply to printing on various media including the following.

Plain paper

Letterhead or preprinted forms

° Envelopes ° Brochures

° Photos ° Labels

To print from a computer (Windows)

ENWW

-

Load the supported media in the correct tray.

For more information, see Supported media sizes.

On the File menu in the software program, click Print.

Make sure your printer is selected.

Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options,
Printer Setup, Printer Properties, Printer, or Set Preferences.

Set the correct print options for your type of media (plain paper, letterhead or preprinted, envelope,
photo paper, label, and so forth).

The following table describes the tabs and options that might be available in your software program.

Tab Description

Printing Shortcuts A printing shortcut stores the settings that are appropriate for a particular kind of job, so that you
can set all the options with a single click.

This tab displays the current printing shortcuts and their settings, such as paper type, paper
source, and color or grayscale.

Paper/Quality This tab contains settings that define the type of print job. For example, printing on envelopes
requires different size, source, and type of paper than printing on plain paper.

You can select from the following options:

Paper size: Includes Letter, Envelope #10, and Japanese Envelope Chou #3
Paper source: Includes Printer Auto Select, Manual Feed, Tray 1, and Tray 2

Paper type: Includes Plain, Letterhead, Preprinted, Envelope, HP Advanced Photo Papers,
HP Brochure Matte 180g, and Labels

NOTE: If Alternative Letterhead Mode (ALM) is enabled, and you are printing on
letterhead, preprinted, or prepunched forms, select Letterhead, Preprinted, or Prepunched
as the paper type. For more information, see Load letterhead or preprinted forms.

Special pages: Includes front and back covers, blank sheets, and preprinted sheets

Print quality: Includes Professional (for high-quality jobs) and General Office (for everyday
jobs)

NOTE: You cannot print envelopes in General Office mode.

Print from a computer
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Tab Description

Effects This tab contains settings that temporarily affect the presentation of the print job.
You can select from the following options:

e  Resizing options: Includes actual size, a percentage of actual, or scaled to a specific media
size such as Letter or Envelope #10

. Watermarks: Includes Confidential and Draft

Finishing This tab contains settings that influence the output of the print job.
You can select from the following options:

e  Print on both sides: Includes the option to print with room for binding on the left, right, or
neither side

e  Pages per sheet: Print more than one page per sheet, with the option to print borders
around each page

e  Orientation: Includes Portrait and Landscape

Color This tab contains settings for printing in color or grayscale.
You can select from the following:

e  Printin Grayscale: Print in black ink only, or high-quality grayscale (which uses the color
cartridges in addition to the black cartridge)

o  Color Themes: These options determine how colors are rendered. They include various red-
green-blue themes such as in Default, Photo, or Vivid. For more information, see To adjust
or manage colors.

Advanced This tab contains settings that you may use or change infrequently.
You can select from the following:
o  (Copies: Select the number of copies and whether to collate them
e  Reverse page order: Prints from the last page of the job to the first page
e  Print all text as black: Helps reduce color cartridge usage

. Ink Settings: Use the sliders to select the dry time, saturation level, and black ink spread
for the print job. For more information, see To adjust or manage colors.

6.  Click OK to return to the Properties dialog box.

7. Click OK, and then click Print or click OK in the Print dialog box.

[%’ NOTE: After printing, remove any special media, such as envelopes or photo paper, from the product.

To print from a computer (0S X)

These instructions apply to printing on various media including the following.

e  Plain paper ° Envelopes e  Brochures

o  Letterhead or preprinted forms ° Photos o  Labels
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To print from a computer (0S X)

1.

6.

Load the supported media in the correct tray.

For more information, see Supported media sizes.

On the File menu in the software program, click Print.

Make sure your printer is selected.

In the Presets menu, select a printing preset if needed.

On the Paper/Quality tab, click the pop-up menu next to the media type.

Set the correct print options for your media (plain paper, letterhead, preprinted, prepunched, envelope,
photo paper, label, and so forth). Print options can include size, type, tray, print resolution, and
automatic adjustments.

If you do not see options on the Print dialog box, click Show Details.

Click Print .

4" NOTE:  After printing, remove any special media, such as envelopes or photo paper, from the product.

To set up printing shortcuts (Windows)

1.

2.

5.

6.

7.

On the File menu in the software program, click Print.
Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options,
Printer Setup, Printer Properties, Printer, or Set Preferences.

Click the Printing Shortcuts tab.

Select an existing shortcut as a base.

[%f NOTE: Always select a shortcut before adjusting any of the settings on the right side of the screen. If

you adjust the settings and then select a shortcut, all your adjustments are lost.

Select the print options for the new shortcut.
Click the Save As button.

Type a name for the shortcut, and click the OK button.

To set up printing presets (0S X)

ENWW

1.

2.

On the File menu in the software program, click Print.
Make sure your printer is selected.

From the Presets pop-up menu, select Default Settings.
Click Save Current Settings as Preset.

Type a descriptive name for the preset, and save it for Only this printer or All printers.
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To adjust or manage colors

Adjust the color of print output for the product by changing the settings in the printer driver software.

° Choose a preset color theme for a print job

° Adjust the color options for a print job manually

L4 Match colors to your computer screen

° Control access to color printing

Choose a preset color theme for a print job

1. Onthe File menu in the software program, click Print.

2.  Make sure your printer is selected.

3.  Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options,
Printer Setup, Printer Properties, Printer, or Set Preferences.

4. Click the Color tab, and select a color theme from the Color Themes drop-down list (Windows) or the
RGB Color pop-up menu (0S X).

Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this
theme, manage color in the software program or in the operating system for correct rendering.

Vivid: The product increases the color saturation in the midtones. Use this theme when printing
business graphics.

Photo: The product interprets RGB color as if it were printed as a photograph using a digital mini
lab. The product renders deeper, more saturated colors differently than with the Default (SRGB)
theme. Use this theme when printing photos.

Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color
space rather than sRGB. Turn off color management in the software program when using this
theme.

None: No color theme is used.

Adjust the color options for a print job manually

58

Use the printer driver software to clear default color settings and adjust settings manually. Use the built-in
help in the driver software to understand how each setting affects print output.

1. Onthe File menu in the software program, click Print.

2. Make sure your printer is selected.

3. Do one of the following.

Chapter 6 Print

Windows: Click the link or button that opens the Properties dialog box.

Depending on your software application, this link or button might be called Properties , Options,
Printer Setup, Printer Properties, Printer, or Set Preferences.

0S X: From the Copies & Pages pop-up menu, select Color. Then, deselect HP EasyColor.
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4.  Continue to the Advanced tab or pane.
e  Windows: On the Advanced tab, click Ink Settings.
e  0SX: Click the disclosure triangle next to Advanced.
5. Usethesliders to make the following adjustments.

e  Dry Time: Move the slider to the right to increase the amount of time that the printer takes to dry a
printed page. Increasing the drying time works best for jobs printed on plain paper.

e  Saturation: Move the slider to the right to increase the amount of ink applied. Increasing the
saturation works best for jobs printed on brochure or photo paper.

e  Black Ink Spread: Move the slider to the left to limit the spread of black ink onto adjacent areas of
color on the printed page. Decreasing the spread works best for jobs printed on plain paper.

[%'/r NOTE: Changing color settings manually can affect output. HP recommends that only color
graphics experts change these settings.

6. Click OK to save your adjustments and close the window, or click Reset to return the settings to the
factory defaults (Windows).

Match colors to your computer screen
For most users, the best method for matching colors is to print SRGB colors.

The process of matching printer output color to your computer screen is complex, because printers and
computer monitors use different methods of producing color. Monitors display colors by using light pixels
that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan, magenta,
yellow, and black) process.

Many factors can influence your ability to match printed colors to those on your monitor:
e  Print media

e  Printing process (cartridge, press, or laser technology, for example)

e  QOverhead lighting

e  Personal differences in perception of color

e  Software programs

e  Printer drivers

° Computer operating systems

e  Monitors

e  Video cards and drivers

e  Operating environment (humidity, for example)

Control access to color printing

HP’s suite of color access control tools allows you to enable or disable color by individual users or groups and
applications. For more information, visit the HP Universal Print Driver website.
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Print with HP ePrint

With HP ePrint, you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile device.
HP ePrint works with any email-capable device. If you can email, you can print to an HP ePrint-enabled
product. For more details, visit the HP Connected website.

To use HP ePrint, ensure the following:
e  You have an Internet- and email-capable computer or mobile device.

° HP Embedded Web Server and HP ePrint are enabled on the printer. For more information, see HP
Embedded Web Server.

Print off site by sending an email with the HP ePrint app

If you are on the road, you can print a document by sending an email with the HP ePrint app to your HP ePrint-
enabled printer. See Web Services for more information.

[%’/]’9 NOTE: Obtain your HP ePrint email address while in the office. For instructions, see HP ePrint .

1. Onyour computer or mobile device, open your email application.
2. Create a new email message, and then attach the file that you want to print.

3.  Enter the HP ePrint email address in the “To” field, and then select the option to send the email
message.

[:?’”f’ NOTE: Do not enter any additional email addresses in either the "To" or "Cc" fields. The HP ePrint
server does not accept print jobs if there are multiple email addresses.

Print from an on-site computer or mobile device

If you are at home or in the office, you can print from a smartphone or tablet to your printer easily.

[%,/r NOTE: If you want to print without accessing the network, see Use Wi-Fi Direct to connect a computer or
device to the product for more information.

1. Make sure your mobile device and printer are on the same network.
2. Select the photo or document you want to print and choose your printer.

3.  Confirm print settings and print.

Print with AirPrint (0S X)

Printing using Apple’s AirPrint is supported for iPad (i0S 4.2), iPhone (3GS or later), iPod touch (third
generation or later), and Mac (0S X v10.9 or later).

To use AirPrint, ensure the following:

e  The printer and the Apple device are connected to the same network as your AirPrint-enabled device. For
more information, visit the HP Mobile Printing website. If a local version of this website is not available
in your country/region, you might be directed to the HP Mobile Printing site in another country/region or
language.

e Load paper that matches the paper settings of the printer.
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To re-enable AirPrint

AirPrint is enabled, by default. If it becomes disabled, you can use the following instructions to enable it
again.

1.  Openthe EWS. For more information, see Open the EWS.
2. Onthe Network tab, click AirPrint and then click Status.

3. Inthe AirPrint Status row, click Turn On AirPrint.
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Tips for print success

Cartridge tips

Paper loading tips

Printer settings tips (Windows)

Printer settings tips (0S X)

Cartridge tips

If the print quality is unacceptable, see Improve print quality for more information.

Use Original HP cartridges.

Original HP cartridges are designed and tested with HP printers and papers to help you easily produce
great results, time after time.

[:?’”i’> NOTE: HP cannot guarantee the quality or reliability of non-HP cartridges. Product service or repairs

required as a result of using a non-HP cartridge will not be covered under warranty.

If you believe you purchased Original HP cartridges, visit the HP anticounterfeit website.

Install the black and color cartridges correctly.

For more information, see Replace cartridges.

Check the estimated cartridge levels to make sure there is sufficient ink.
Supply level warnings and indicators provide estimates for planning purposes only.

For more information, see Check the estimated cartridge levels.

Ej?’y NOTE: When you receive a low-cartridge warning message, consider having a replacement cartridge

available to avoid possible printing delays. You do not need to replace the cartridges until prompted to.

To protect the product from damage, always turn off the printer by using the power button on the front.

Paper loading tips

For more information, see Supported media sizes.

Ensure the paper is loaded in the input tray properly, and set the correct media size and media type.
Upon loading paper in input tray, you will be prompted to set the media size and media type.

Load a stack of paper (not just one page). All the paper in the stack should be of the same size and type
to avoid a paper jam.

Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the guides do
not bend the paper in the tray.

Printer settings tips (Windows)

To change default print settings, do one of the following:
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In the HP Printer Assistant, click Print, and then click Set Preferences. For more information, see
Open the HP Printer Assistant.

On the File menu in the software program, click Print. Open the Printer Properties dialog box.

e  Onthe Color or Finishing tab of the printer driver, set the following options as needed:

Print in Grayscale: Allows you to print a black-and-white document using only the black cartridge.
Click Black Ink Only, and then click OK .

Pages per sheet: Helps you specify the order of the pages if you print document in more than two
pages per sheet.

Booklet Layout: Allows you to print a multiple-page document as a booklet. It places two pages on
each side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding
method from the drop-down list, and then click OK .

o  Leftbinding: The binding side after folded into a booklet appears at the left side. Select the
option if your reading habit is from left to right.

o  Right binding: The binding side after folded into a booklet appears at the right side. Select
the option if your reading habit is from right to left.

Print page borders: Allows you to add the borders to the pages if you print the document with two
or more pages per sheet.

e  You can use printing shortcuts to save time setting printing preferences.

Printer settings tips (0S X)

e Inthe software program, be sure to select the correct paper size loaded in the printer.

a.
b.

C.

From the File menu, select Page Setup.
In Format For, make sure your printer is selected.

From the pop-up menu, select Paper Size.

e Inthe software program, be sure to select the correct paper type and quality loaded in the printer.

a.

b.

On the File menu in the software program, click Print.

From the Copies & Pages pop-up menu, select Paper/Quality, and select the correct paper type
and quality.

e  To print a black-and-white document using only the black cartridge, do the following.

a.

b.
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On the File menu in the software program, click Print.
In the Print window, from the pop-up menu, select Copies & Pages, and then select Color.
Deselect HP EasyColor, and then select Print Color as Gray.

Select Black Ink Only.

Tips for print success
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7 Solve problems

° Problem-solving checklist

° Information pages

° Factory-set defaults

° Cleaning routines

e Jams and paper-feed issues

° Cartridge issues

° Printing issues

° Connectivity issues

e  Wireless network issues

e  Product software issues (Windows)

e  Product software issues (0S X)
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Problem-solving checklist

Follow these steps when trying to solve a problem with the product.

° Check that the product power is on

° Check the control panel for error messages

° Test print functionality

e Trysending a print job from a computer

° Factors that affect product performance

Check that the product power is on
1. If the power button is not lit, press it to turn the product on.

2. If the power button does not seem to work, ensure that the power cable is connected to both the
product and the electrical or AC outlet.

3. If the product is still not powering up, check the power source by connecting the power cable to a
different electrical or AC outlet.

Check the control panel for error messages

The control panel should indicate ready status. If an error message appears, resolve the error.

Test print functionality

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {}.

3. Touch Reports, and then touch Printer Status Report to print a test page.

4. If thereport does not print, make sure paper is loaded in the tray, and check the control panel to see if
paper is jammed inside the product.

[%f NOTE: Make sure the paper in the tray meets specifications for this product.

Try sending a print job from a computer
1.  Use aword-processing program to send a print job to the product.
2. Ifthejob does not print, make sure you selected the correct printer driver.

3. Uninstall and then reinstall the product software.

Factors that affect product performance
Several factors affect the time it takes to print a job:
e  The software program that you are using and its settings

e  The use of special paper (such as heavy paper and custom-size paper)
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e  Product processing and download time

e  The complexity and size of graphics

e  The speed of the computer you are using

e  The USB or network connection

e  Whether the product is printing in color or in monochrome

e  The type of USB drive, if you are using one

Information pages

Information pages reside within the product memory. These pages help diagnose and solve problems with
the product.

[%’/r NOTE: If the product language was not correctly set during installation, you can set the language manually
so the information pages print in one of the supported languages. Change the language by using the
Preferences menu on the Setup menu in the control panel or by using the HP Embedded Web Server.

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. Onthe control panel dashboard, touch {}.

3. Touch Reports to view the menu.

4. Touch the name of the report that you want to print.

Menu Item Description

Printer Status Report Prints the cartridge status. Includes the following information:
e  Estimated proportion of cartridge life remaining

NOTE: Cartridge-level alerts and indicators provide estimates for planning purposes only. When you
receive a low-cartridge alert, consider having a replacement cartridge available to avoid possible printing
delays. You do not need to replace the cartridges until you are prompted to.

° Approximate number of pages remaining
e  Part numbers for HP cartridges
e Number of pages printed

° Information about ordering new HP cartridges and recycling used HP cartridges

Print Quality Report Prints a page that helps solve problems with print quality

Web Access Test Report Shows the current configuration settings and diagnostic results for the local network, gateway, DNS, proxy,
and test server. This report is useful for resolving problems accessing the web.

Usage Page Shows a count of all paper sizes that have passed through the product; lists whether they were monochrome
or color, simplex or duplex, and reports the page count. This report is useful for reconciling contractual billing
statements.
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Menu Item

Description

Network Configuration Page

Displays status for:

o  Network hardware configuration
e  Enabled features

e TCP/IP and SNMP information

e Network statistics

e  Wireless network configuration (wireless models only)

Event Log Prints a log of errors and other events during product use.
PCL Font List Prints a list of all installed PCL fonts

PCL6 Font List Prints a list of all installed PCL6 fonts

PS Font List Prints a list of all installed PS fonts
Factory-set defaults

NOTICE: Restoring the factory-set defaults returns all of the product and network settings to the factory

defaults. The procedure then automatically restarts the product.

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or

touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {}.

3.  Touch Printer Maintenance, and then touch Restore.

4. Touch Restore Factory Defaults, and then touch Continue.

The product automatically restarts.

Cleaning routines

° Clean the printhead

° Clean the touch screen

Clean the printhead

During the printing process, paper, ink, and dust particles can accumulate inside the product. Over time, this

buildup can cause print-quality problems such as specks or smearing.

This product automatically services itself, running cleaning routines that can correct most of these problems.

For problems that the product cannot automatically solve, use the following routine to clean the printhead.

Ej?"” NOTE: This routine uses ink to clean the printhead. Use the routine only to correct print quality errors. Do

not use it for periodic maintenance.
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X TIP: Turning the product off properly by pressing the power button on the front of the product helps keep
the printhead from clogging and creating print-quality problems.

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {C}.

3. Touch Printer Maintenance to view the list of cleaning and alignment routines.

4. Touch Clean Printhead Level 1, and then follow the prompts on the control panel. If necessary, load
paper in the requested tray.

A page feeds through the product slowly. Discard the page when the process is completed.

5. If the printhead is still not clean, touch Clean Printhead Level 2, and follow the prompts on the control
panel. If that does not work, continue with the next cleaning routine. Continue down the list of cleaning
routines, if needed.

A page feeds through the product slowly. Discard the page when the process is completed.

Clean the touch screen

Clean the touch screen whenever it is necessary to remove fingerprints or dust. Wipe the touch screen gently
with a clean, water-dampened, lint-free cloth.

NOTICE: Use water only. Solvents or cleaners can damage the touch screen. Do not pour or spray water
directly onto the touch screen.
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Jams and paper-feed issues

Try these steps to solve paper-handling problems.

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1.
2,

Open the product and remove any jammed sheets of paper.
Load the tray with the correct size of paper for your job.

Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the guides with
the paper-size markings in the bottom of the tray.

Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the
paper. Return the stack of paper to the tray.

Check the control panel to see if the product is waiting for you to acknowledge a prompt to feed the
paper manually through Tray 1, the multipurpose tray on the left side of the product. Load paper, and
continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
Make sure all paper in the tray is the same type and size.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the
stack, and then return less paper to the tray.
Even if the tray is not overfilled, try using a lower stack of media, such as half.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the guides with
the paper-size markings in the bottom of the tray.

6.  Print from another tray.

Prevent paper jams
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To reduce the number of paper jams, try these solutions.

1.

Use only paper that meets HP specifications for this product. Lightweight, short-grain paper is not
recommended.

Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
Use paper that has not previously been printed or copied on.

Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the
stack, and then return some of the paper to the tray.
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5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so
they are touching the paper stack without bending it.

6.  Make sure that the tray is fully inserted in the product.

7. Ifyou are printing on heavy, embossed, or perforated paper, use Tray 1, the multipurpose tray on the
left side of the printer, and then feed sheets manually one at a time.

Clear jams
° Jam locations

e  (learjamsin Tray 1 (multipurpose tray)

° Clear jamsin Tray 2

° Clear jams in the left door

° Clear jams in the output bin

° Clear jams in the duplexer

[%9 NOTE: For best results, do not turn off the product before clearing paper jams.

Jam locations

Jams can occur in these locations:

1 Output bin
2 Tray 2

3 Tray 1

4 Left door

Traces of ink might remain in the product after a jam. This problem typically resolves itself after a few sheets
have been printed.

Clear jams in Tray 1 (multipurpose tray)

A If the jammed sheet is visible and easily accessible in Tray 1, pull it from Tray 1.

[%]’9 NOTE: If the sheet tears, make sure that all of the fragments are removed before you resume printing.
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Clear jamsin Tray 2

1.  Open Tray 2 by pulling it out and releasing the latch at the rear left of the tray.

2. Remove the jammed sheet by pulling it to the right and then out of the product.
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3. Close Tray 2.

[%’ NOTE: To close the tray, push in the middle or with even pressure on both sides. Avoid pushing on one
side only.

Clear jams in the left door

1.  Open the left door.

2. Gently remove any visible paper from the rollers and delivery area.

[%’ NOTE: If the sheet tears, make sure that all fragments are removed before you resume printing. Do
not use sharp objects to remove fragments.

3. Close the left door.

Clear jams in the output bin

1. Look for jammed paper in the output bin area.
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2. Remove any visible media.

[%Y NOTE: If the sheet tears, remove all fragments before you resume printing.

3.

Clear jams in the duplexer

1.  Open the left door.

2. Remove the duplexer by pulling it out with both hands. Set the duplexer aside, upright, on a piece of
paper to prevent spills.

NOTICE: When pulling out the duplexer, avoid making direct contact with the black cylinder to prevent
ink smear on skin or clothes.
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3. Lower the platen by pressing down on the green tab. This will cause the product to try to feed the sheet
through the print zone. You may need to gently pull on the sheet if it does not feed. Remove the sheet.

4. Lift the green tab to place the platen back into its operating position.

5. Reinstall the duplexer.

6.

Cartridge issues

Refilled or remanufactured cartridges

HP cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP
products, HP cannot influence their design or control their quality. If you are using a refilled or
remanufactured cartridge and are not satisfied with the print quality, replace the cartridge with a genuine HP
cartridge.

[%'/]’9 NOTE: If you replace a non-HP cartridge with a genuine HP cartridge, the printhead may still contain non-
HP ink until the printhead is depleted of that ink and is supplied with ink from the newly installed, genuine HP
cartridge. Until the non-HP ink is depleted, print quality will be affected.
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Interpret control panel messages for cartridges

Cartridge Depleted
Description
The cartridge is at the end of its useful life, and the product will no longer print.
Recommended action

Depleted cartridges must be replaced to resume printing.

Cartridge Low
Description
The cartridge is nearing the end of its useful life.
Recommended action

Printing can continue, but consider having a replacement cartridge on hand. You do not need to replace the
cartridges until prompted to.

Cartridge Very Low
Description
The cartridge is near the end of its useful life.
Recommended action

Have a replacement cartridge on hand. You do not need to replace the cartridges until prompted to.

Counterfeit or used [color] cartridge installed
Description
The original HP ink in this cartridge has been depleted.
Recommended action

Click OK to continue printing or replace with genuine HP cartridge.

Do not use SETUP cartridges
Description
SETUP cartridges cannot be used after the device has been initialized.
Recommended action

Remove and install non-SETUP cartridges.

Genuine HP cartridge installed
Description

A genuine HP cartridge was installed.

ENWW Cartridge issues
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Recommended action

No action necessary.

Incompatible [color]
Description

You have installed a cartridge that is intended for use in a different HP product model. The product will NOT
function with this print cartridge installed.

Recommended action

Install the correct cartridge for this product.

Incompatible cartridges
Description
— The contacts on the cartridge might not be making a connection to the printer.
— The cartridge is not compatible with your printer.
Recommended action

—  Carefully clean the contacts on the cartridge by using a soft, lint-free cloth and insert the cartridge
again.

— Remove this cartridge immediately and replace with a compatible cartridge.

Install [color] cartridge
Description

This message can appear during the initial set up of the product and may also appear after the initial set up of
the product has been completed.

If this message appears during initial setup, it means one of the color cartridges is not installed with the door
closed. The product will not print if a cartridge is missing.

If this message appears after the initial setup of the product, it means that the cartridge is missing or is
installed but damaged.

Recommended action

Install or replace the indicated color cartridge.

Non-HP cartridges installed
Description
No action necessary, this is a notification only.
Recommended action
No action necessary, this is a notification only.

However, HP cannot recommend the use of non-HP supplies, either new or remanufactured. Touch OK to
continue printing or replace the cartridge with a genuine HP cartridge.
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Printer Failure

Description
The printer refuses to function.
Recommended action

Have a replacement cartridge on hand. You do not need to replace the cartridges until prompted to.

Problem with Print System

Description

The cartridge identified in the message is missing, damaged, incompatible, or inserted into the wrong slot in
the printer.

Recommended action

Printing functionality is disabled. Visit the HP Customer Support website.

Problem with Printer Preparation

Description

The printer clock has failed and cartridge preparation may not be complete. The estimated Cartridge Level
gauge might be inaccurate.

Recommended action

Check the print quality of your print job. If it is not satisfactory, running the printhead cleaning procedure
from the toolbox might improve it.

Problem with SETUP cartridges

Description
There is a problem with the SETUP cartridges and the printer cannot complete system initialization.
Recommended action

Visit the HP Customer Support website.

Use SETUP cartridges
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Description

The SETUP cartridges have been removed before the product has completed initialization.
Recommended action

Use the SETUP cartridges that came with your product for product initialization.

When you first set up the printer, you must install the SETUP cartridges that shipped in the box with the
printer. These cartridges calibrate your printer before the first print job. Failure to install the SETUP cartridges
during the initial product setup causes an error. If you installed a set of regular cartridges, remove them and
install the SETUP cartridges to complete printer setup. After printer setup is complete, the printer can use
regular cartridges.

Cartridge issues
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If you still receive error messages and the printer cannot complete system initialization, visit the HP Customer
Support website.

Used [color] installed

Description

A used, but still genuine, HP color cartridge has been installed or moved.

Recommended action

You have a used, but still genuine, HP cartridge installed. No action required.

Printing issues

The product does not print
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If the product does not print at all, try the following solutions.

1.

Make sure the product is turned on and that the control panel indicates it is ready.
— If the control panel does not indicate the product is ready, turn the product off and then on again.
— If the control panel indicates the product is ready, try sending the job again.

If the control panel indicates the product has an error, resolve the error and then try to print a test page
from the control panel. If the test page prints, there may be a communication problem between the
product and the computer you are trying to print from.

Make sure the cables are all connected correctly. If the product is connected to a network, check the
following items:

— Check the light next to the network connection on the product. If the network is active, the light is
green.

— Make sure that you are using a network cable and not a phone cord to connect to the network.
— Make sure the network router, hub, or switch is turned on and that it is working correctly.

Install the HP software from 123.hp.com/pagewide (recommended) or from the HP software CD
provided with the printer. Using generic printer drivers can cause delays clearing jobs from the print
queue.

From the list of printers on your computer, right-click the name of this product, click Properties , and
open the Ports tab.

— If you are using a network cable to connect to the network, make sure the printer name listed on
the Ports tab matches the product name on the product configuration page.

— If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

If you are using a personal firewall system on the computer, it might be blocking communication with
the product. Try temporarily disabling the firewall to see if it is the source of the problem.

If your computer or the product is connected to a wireless network, low signal quality or interference
might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

Make sure the computer meets the minimum specifications for this product. For a list of specifications,
visit HP Customer Support .

If the paper type setting is not correct for the type of paper you are using, change the setting to the
correct paper type.

If your computer or the product is connected to a wireless network, low signal quality or interference
might be delaying print jobs.

If Quiet Mode is on, turn it off. This mode slows down the print speed. For more information, see Quiet
Mode.

Improve print quality

You can prevent most print-quality problems by following these guidelines.

Check for genuine HP cartridges

Use paper that meets HP specifications

Use the correct paper type setting in the printer driver

Use the printer driver that best meets your printing needs

Align the printhead

Print a print-quality report

Check for genuine HP cartridges

Your cartridge may not be a genuine HP cartridge. For more information, see Counterfeit HP cartridges.
Replace it with a genuine HP cartridge.

Use paper that meets HP specifications

ENWW

Use different paper if you are having any of the following problems:

The printing is too light or seems faded in areas.
Specks of ink are on the printed pages.

Ink smears on the printed pages.

Printed characters seem misformed.

Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when
selecting paper:

Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles,
voids, staples, and curled or bent edges.

Use paper that has not been previously printed on.
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° Use paper that is designed for use in PageWide printers.

e  Use paper that is not too rough. Using smoother paper generally results in better print quality.

9

B NOTE: Based on HP internal testing using a range of plain papers, HP highly recommends using papers with
the ColorLok® logo for this product. For details, visit the HP print permanence website.

Use the correct paper type setting in the printer driver
Check the paper type setting if you are having any of the following problems:
e Ink smears on the printed pages.
e  Repeated marks occur on the printed pages.
e  Printed pages are curled.

e  Printed pages have small unprinted areas.

Change the paper type and size setting (Windows)
1. Onthe File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3.  Click the Paper/Quality tab.
4. From the Paper Type drop-down list, click More.
5. Expand the list of Type Is options.
6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click 0K .

Change the paper type and size setting (0S X)
1. From the File menu, select Page Setup.
2. InFormat For:, make sure your printer is selected.
3. From the Paper Size pop-up menu, select the correct size.
4. From the Copies & Pages pop-up menu, select Paper/Quality.

5.  From the Media type: pop-up menu, select the correct media type.

Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics, missing
text, missing graphics, incorrect formatting, or substituted fonts.
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HP PCL 6 driver e  Provided as the default driver. This driver is automatically installed when installing the product
from 123.hp.com/pagewide (recommended) or from the HP software CD provided with the
printer.

e Recommended for all Windows environments. For Windows 7 and later, this driver is XPS-
based. For Windows 2003, XP, and Vista, a more basic PCL 6 print driver is provided.

e  Provides the overall best speed, print quality, and product-feature support for most users.

HP UPD PS driver e Recommended for printing with Adobe® software programs or with other highly graphics-
intensive software programs.

e Provides support for printing from postscript emulation needs, or for postscript flash font
support.

° This driver is available for download at HP Universal Print Driver .

HP UPD PCL6 ° Recommended for printing in all Windows environments.

e  Provides the overall best speed, print quality, and printer feature support for users in managed
environments.

° Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows
environments.

° This driver is available for download at HP Universal Print Driver .

[:?’/r NOTE: Download additional printer drivers from the HP Customer Support website.

Align the printhead

1.  Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

2. On the control panel dashboard, touch {C}.
3.  Touch Printer Maintenance, and then touch Align Printhead.

Print a print-quality report

Run a Print Quality report and follow the instructions. For more information, see Information pages.

Connectivity issues

Solve USB direct-connect problems
If you have connected the product directly to a computer, check the USB cable.
e  \Verify that the cable is connected to the computer and to the product.
e  Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

e  \Verify that the cable is working correctly by connecting it with another product. Replace the cable if
necessary.
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Solve network problems

Check the following items to verify that the product is communicating with the network. Before beginning,
print a configuration page from the control panel and locate the product IP address that is listed on this page.

° Poor physical connection

° The computer is using the incorrect IP address for the product

° The computer is unable to communicate with the product

° The product is using incorrect link and duplex settings for the network

° New software programs might be causing compatibility problems

° The computer or workstation might be set up incorrectly

° The product is disabled, or other network settings are incorrect

Poor physical connection
1.  Verify that the product is attached to the correct ethernet port using the proper cable.
2. Verify that cable connections are securely attached.

3. Look at the Ethernet port on the back of the product, and verify that the amber activity light and the
green link-status light are active.

4. If the problem continues, try a different cable or port on the network router, switch, or hub.

The computer is using the incorrect IP address for the product

1. Onthe computer, open the printer properties and click the Ports tab. Verify that the current IP address
for the product is selected. The product IP address is listed on the product configuration page or through
the control panel.

2. Ifyouinstalled the product using an HP standard TCP/IP port, select the box labeled Always print to this
printer, even if its IP address changes.

3. Ifyouinstalled the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP
address.

If you installed the product from 123.hp.com/pagewide (recommended) or from the HP software CD
provided with the printer, you can view or change the product IP address using the following steps:

a. Open the HP Printer Assistant. For more information, see Open the HP Printer Assistant.

b. Click the Tools tab.

c. Click Update IP Address to open a utility that reports the known (“previous”) IP address for the
product and allows you to change the IP address, if necessary.

4. IftheIP address is correct, delete the product entry from the list of installed printers, and then add it
again.

The computer is unable to communicate with the product

1.  Test network communication by pinging the product.
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a. Openacommand-line prompt on your computer. For Windows, click Start, click Run, and then
type cmd.

b. Typeping followed by the IP address for your product.
¢. If the window displays round-trip times, both the network and device are working.

2. If the ping command failed, verify that the network router, hubs, or switches are on, and then verify that
the network settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

HP recommends leaving this setting in automatic mode (the default setting). If you change these settings,
you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly
1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect
1.  Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.

Wireless network issues

Wireless connectivity checklist

e  The product and the wireless router are turned on and have power. Also make sure the wireless radio in
the product is turned on.

e  Theservice set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you are
not sure the SSID is correct, run the wireless setup again.

e  With secured networks, make sure the security information is correct. If the security information is
incorrect, run the wireless setup again.

e |f the wireless network is working correctly, try accessing other computers on the wireless network. If
the network has Internet access, try connecting to the Internet over another wireless connection.

e  The encryption method (AES or TKIP) is the same for the product as it is for the wireless access point,
such as a wireless router (on networks using WPA security).

e  The product is within the range of the wireless network. For most networks, the product must be within
30 m (100 ft) of the wireless access point (wireless router).

e  Obstacles do not block the wireless signal. Remove any large metal objects between the access point
and the product. Make sure poles, walls, or support columns containing metal or concrete do not
separate the product and wireless access point.
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The product is located away from electronic devices that might interfere with the wireless signal. Many
devices can interfere with the wireless signal including motors, cordless phones, security system
cameras, other wireless networks, and some Bluetooth devices.

The printer driver is installed on the computer.
You have selected the correct printer port.

The computer and product connect to the same wireless network.

The product does not print, and the computer has a third-party firewall installed

1.

2.

Update the firewall with the most recent update available from the manufacturer.

If programs request firewall access when you install the product or try to print, make sure you allow the
programs to run.

Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product

Make sure that the router or product connects to the same network that your computer connects to.

1.

Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

On the control panel dashboard, touch {}.

Touch Reports, and then touch Network Configuration Page to print the report.

Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for your computer.

If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure the
wireless setup for your product.

Cannot connect more computers to the wireless product

1.

Make sure that the other computers are within the wireless range and that no obstacles block the signal.
For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

Make sure the product is turned on and in the ready state.
Turn off any third-party firewalls on your computer.
Make sure that the wireless network is working correctly.

a. Open the control panel dashboard (swipe the dashboard tab at the top of any screen downward, or
touch the dashboard area on the home screen).

b.  On the control panel dashboard, touch {}.
¢. TouchReports, and then touch Web Access Report to print the report.

Make sure that the correct port or product is selected.

e  For printers installed without the fully featured installer:

84 Chapter 7 Solve problems ENWW



6.

a.

b.

From the list of printers on your computer, right-click the name of this product, click Printer
Properties, and then open the Ports tab.

Make sure the box is checked next to Virtual printer port for USB.

e If youinstalled the printer software from 123.hp.com/pagewide (recommended) or from the HP
software CD provided with the printer, you can view or change the product IP address using the
following steps:

a.

b.

Click Start.

Click All Programs.
Click HP.

Click your product.

Click Update IP Address to open a utility that reports the known (“previous”) IP address for
the product and allows you to change the IP address, if necessary.

Make sure that your computer is working correctly. If necessary, restart your computer.

The wireless product loses communication when connected to a VPN

Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

Make sure the wireless router is turned on and has power.

The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1.

2.

To verify if the network has lost communication, try connecting other devices to the network.

Test network communication by pinging the network.

a. Openacommand-line prompt on your computer. For Windows, click Start, click Run, and then
type cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

¢. If the window displays round-trip times, the network is working.

To make sure that the router or product connects to the same network that your computer connects to,

print the Network Configuration Page. For instructions, see Information pages.

Product software issues (Windows)

Problem

Solution

A printer driver for the
product is not visible in the

Printer folder
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Reinstall the product software.

Product software issues (Windows)
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Problem Solution

NOTE: Close any applications that are running. To close an application that has an icon in the system tray, right-
click the icon, and select Close or Disable.

e  Try plugging the USB cable into a different USB port on the computer.

An error message was ° Reinstall the product software.
displayed during the
software installation NOTE: Close any applications that are running. To close an application that has an icon in the task bar, right-

click the icon, and select Close or Disable.

e  Check the amount of free space on the drive where you are installing the product software. If necessary, free up
as much space as you can, and reinstall the product software.

° If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready e Print a configuration page from the control panel, and verify the product functionality.
mode, but nothing prints
e  Verify that all of the cables are correctly seated and within specifications. This includes the USB and power
cables. Try a new cable.

e  Verify the IP Address on the Configuration Page matches the IP address for the software port. Use one of the
following procedures:

—  Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista, installed without using
the fully featured installer (such as Add Printer Wizard in Windows):

1. Click Start.

2. Click Settings.

3.  Click Printers.

4. Right-click the product driver icon, and then select Properties .
5.  Click the Ports tab, and then click Configure Port.

6. Verify the IP address, and then click OK or Cancel.

7. If the IP Addresses are not the same, delete the driver, and reinstall the driver using the correct IP
address.

—  Windows 7, installed without using the fully featured installer (such as Add Printer Wizard in Windows):
1. Click Start.
2.  Click Devices and Printers.
3. Right-click the product driver icon, and then select Printer properties.
4. Click the Ports tab, and then click Configure Port.
5. Verify the IP address, and then click OK or Cancel.

6. If the IP Addresses are not the same, delete the driver, and reinstall the driver using the correct IP
address.

— Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista, and Windows 7, installed
using the fully featured installer:

1. Click Start.
2. Click All Programs.

3. Click HP.
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Problem

Solution

4.  Click your product.

5.  Click Update IP Address to open a utility that reports the known (“previous”) IP address for the
product and allows you to change the IP address, if necessary.

Product software issues (0S X)

A print job was not sent to the product that you wanted

1.

2.

Open the print queue and restart the print job.

Another product with the same or similar name might have received your print job. Print a configuration
page to check the product name. Verify that the name on the configuration page matches the product
name in the Printers list.

You are using a generic printer driver when using a USB connection

ENWW

If you connected the USB cable before you installed the software, you might be using a generic printer driver
instead of the driver for this product.

1.

2.

Delete the generic printer driver.

Reinstall the software from the product CD. Do not connect the USB cable until the software installation
program prompts you.

If multiple printers are installed, make sure that you have selected the correct printer in the Format For
pop-up menu in the Print dialog box.

Product software issues (0S X)
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8 Service and support

° Customer support

° HP limited warranty statement

88 Chapter 8 Service and support ENWW



Customer support

If you need help from an HP technical support representative to solve a problem, contact HP Customer

ENWW

Support.
Register your product www.register.hp.com

Download software utilities, drivers, and electronic
documentation

HP Customer Support

Get 24-hour Internet product support and troubleshooting and
download drivers and software, and electronic information

HP Customer Support

Get support for products used with a Mac computer

HP Customer Support

Get telephone support, free during your warranty period, for your
country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in the
box with your product or at HP Customer Support .

Order additional HP service or maintenance agreements

www.hp.com/go/carepack

Customer support
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HP PRODUCT DURATION OF LIMITED WARRANTY

HP PageWide 352dw 1 year

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in
materials and workmanship after the date of purchase, for the period specified above. If HP receives notice of
such defects during the warranty period, HP will, at its option, either repair or replace products which prove to
be defective. Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of
purchase, for the period specified above, due to defects in material and workmanship when properly installed
and used. If HP receives notice of such defects during the warranty period, HP will replace software which
does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a
refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject
to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b)
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d)
operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

HP’s limited warranty is void in the event the printer is attached to an aftermarket apparatus or system that
modifies the printer’s functionality such as a continuous ink system.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY
DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND
FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or provinces do not allow limitations on
the duration of an implied warranty, so the above limitation or exclusion might not apply to you. This
warranty gives you specific legal rights and you might also have other rights that vary from country/region to
country/region, state to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE AND
EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR
LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO
NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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UK, Ireland, and Malta

The HP Limited Warranty is a commercial guarantee voluntarily provided by HP. The name and address of the
HP entity responsible for the performance of the HP Limited Warranty in your country/region is as follows:

UK: HP Inc UK Limited, Cain Road, Amen Corner, Bracknell, Berkshire, RG12 THN
Ireland: Hewlett-Packard Ireland Limited, Liffey Park Technology Campus, Barnhall Road, Leixlip, Co.Kildare

Malta: Hewlett-Packard Europe B.V., Amsterdam, Meyrin Branch, Route du Nant-d'Avril 150, 1217 Meyrin,
Switzerland

United Kingdom: The HP Limited Warranty benefits apply in addition to any legal rights to a guarantee from
seller of nonconformity of goods with the contract of sale. These rights expire six years from delivery of
goods for products purchased in England or Wales and five years from delivery of goods for products
purchased in Scotland. However various factors may impact your eligibility to receive these rights. For further
information, please consult the following link: Consumer Legal Guarantee (www.hp.com/go/eu-legal) or you
may visit the European Consumer Centers website (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the right to
choose whether to claim service under the HP Limited Warranty or against the seller under the legal
guarantee.

Ireland: The HP Limited Warranty benefits apply in addition to any statutory rights from seller in relation to
nonconformity of goods with the contract of sale. However various factors may impact your eligibility to
receive these rights. Consumer statutory rights are not limited or affected in any manner by HP Care Pack. For
further information, please consult the following link: Consumer Legal Guarantee (www.hp.com/go/eu-legal)
or you may visit the European Consumer Centers website (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the right to
choose whether to claim service under the HP Limited Warranty or against the seller under the legal
guarantee.

Malta: The HP Limited Warranty benefits apply in addition to any legal rights to a two-year guarantee from
seller of nonconformity of goods with the contract of sale; however various factors may impact your eligibility
to receive these rights. Consumer statutory rights are not limited or affected in any manner by the HP Limited
Warranty. For further information, please consult the following link: Consumer Legal Guarantee
(www.hp.com/go/eu-legal) or you may visit the European Consumer Centers website (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the
right to choose whether to claim service under the HP Limited Warranty or against the seller under two-year
legal guarantee.

Austria, Belgium, Germany, and Luxemburg

Die beschrankte HP Herstellergarantie ist eine von HP auf freiwilliger Basis angebotene kommerzielle
Garantie. Der Name und die Adresse der HP Gesellschaft, die in lhrem Land fiir die Gewdhrung der
beschrankten HP Herstellergarantie verantwortlich ist, sind wie folgt:

Deutschland: HP Deutschland GmbH, Schickardstr. 32, D-71034 Boblingen

Osterreich: HP Austria GmbH., Technologiestrasse 5, A-1120 Wien

Luxemburg: Hewlett-Packard Luxembourg S.C.A., 75, Parc d'Activités Capellen, Rue Pafebruc, L-8308 Capellen
Belgien: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

Die Rechte aus der beschrankten HP Herstellergarantie gelten zusatzlich zu den gesetzlichen Anspriichen
wegen Sachmangeln auf eine zweijdahrige Gewahrleistung ab dem Lieferdatum. Ob Sie Anspruch auf diese
Rechte haben, hdngt von zahlreichen Faktoren ab. Die Rechte des Kunden sind in keiner Weise durch die
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beschrankte HP Herstellergarantie eingeschrankt bzw. betroffen. Weitere Hinweise finden Sie auf der
folgenden Website: Gewdhrleistungsanspriiche fiir Verbraucher (www.hp.com/go/eu-legal) oder Sie konnen
die Website des Europdischen Verbraucherzentrums (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm) besuchen. Verbraucher haben das
Recht zu wahlen, ob sie eine Leistung von HP gemaR der beschrankten HP Herstellergarantie in Anspruch
nehmen oder ob sie sich gemaR der gesetzlichen zweijahrigen Haftung fiir Sachmangel (Gewahrleistung) sich
an den jeweiligen Verkdufer wenden.

Belgium, France, and Luxemburg
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La garantie limitée HP est une garantie commerciale fournie volontairement par HP. Voici les coordonnées de
l'entité HP responsable de l'exécution de la garantie limitée HP dans votre pays:

France: HP France SAS, société par actions simplifiée identifiée sous le numéro 448 694 133 RCS Evry, 1
Avenue du Canada, 91947, Les Ulis

G.D. Luxembourg: Hewlett-Packard Luxembourg S.C.A., 75, Parc d'Activités Capellen, Rue Pafebruc, L-8308
Capellen

Belgique: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

France: Les avantages de la garantie limitée HP s'appliquent en complément des droits dont vous disposez au
titre des garanties légales applicables dont le bénéfice est soumis a des conditions spécifiques. Vos droits en
tant que consommateur au titre de la garantie légale de conformité mentionnée aux articles L. 211-4 a L.
211-13 du Code de la Consommation et de celle relatives aux défauts de la chose vendue, dans les conditions
prévues aux articles 1641 a 1648 et 2232 du Code de Commerce ne sont en aucune facon limités ou affectés
par la garantie limitée HP. Pour de plus amples informations, veuillez consulter le lien suivant : Garanties
légales accordées au consommateur (www.hp.com/go/eu-legal). Vous pouvez également consulter le site
Web des Centres européens des consommateurs (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Les consommateurs ont le droit de
choisir d’exercer leurs droits au titre de la garantie limitée HP, ou auprés du vendeur au titre des garanties
légales applicables mentionnées ci-dessus.

POUR RAPPEL:
Garantie Légale de Conformité:

« Le vendeur est tenu de livrer un bien conforme au contrat et répond des défauts de conformité existant lors
de la délivrance.

Il répond également des défauts de conformité résultant de l'emballage, des instructions de montage ou de
l'installation lorsque celle-ci a été mise a sa charge par le contrat ou a été réalisée sous sa responsabilité ».

Article L211-5 du Code de la Consommation:
« Pour étre conforme au contrat, le bien doit:
1° Etre propre a l'usage habituellement attendu d'un bien semblable et, le cas échéant:

- correspondre a la description donnée par le vendeur et posséder les qualités que celui-ci a présentées a
l'acheteur sous forme d'échantillon ou de modéle;

- présenter les qualités qu'un acheteur peut [égitimement attendre eu égard aux déclarations publiques faites
par le vendeur, par le producteur ou par son représentant, notamment dans la publicité ou l'étiquetage;

2° Ou présenter les caractéristiques définies d'un commun accord par les parties ou étre propre a tout usage
spécial recherché par l'acheteur, porté a la connaissance du vendeur et que ce dernier a accepté ».
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Article L211-12 du Code de la Consommation:
« L'action résultant du défaut de conformité se prescrit par deux ans a compter de la délivrance du bien ».
Garantie des vices cachés

Article 1641 du Code Civil : « Le vendeur est tenu de la garantie a raison des défauts cachés de la chose vendue
qui la rendent impropre a l'usage auquel on la destine, ou qui diminuent tellement cet usage que l'acheteur ne
l'aurait pas acquise, ou n'en aurait donné qu'un moindre prix, s'il les avait connus. »

Article 1648 alinéa 1 du Code Civil:

« L'action résultant des vices rédhibitoires doit étre intentée par l'acquéreur dans un délai de deux ans a
compter de la découverte du vice. »

G.D. Luxembourg et Belgique: Les avantages de la garantie limitée HP s'appliquent en complément des droits
dont vous disposez au titre de la garantie de non-conformité des biens avec le contrat de vente. Cependant,
de nombreux facteurs peuvent avoir un impact sur le bénéfice de ces droits. Vos droits en tant que
consommateur au titre de ces garanties ne sont en aucune facon limités ou affectés par la garantie limitée
HP. Pour de plus amples informations, veuillez consulter le lien suivant : Garanties légales accordées au
consommateur (www.hp.com/go/eu-legal) ou vous pouvez également consulter le site Web des Centres
européens des consommateurs (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Les consommateurs ont le droit de choisir de réclamer un service
sous la garantie limitée HP ou auprés du vendeur au cours d'une garantie légale de deux ans.

Italy

La Garanzia limitata HP € una garanzia commerciale fornita volontariamente da HP. Di seguito sono indicati
nome e indirizzo della societa HP responsabile della fornitura dei servizi coperti dalla Garanzia limitata HP nel
vostro Paese:

Italia: HP Italy S.r.l., Via G. Di Vittorio 9, 20063 Cernusco S/Naviglio

| vantaggi della Garanzia limitata HP vengono concessi ai consumatori in aggiunta ai diritti derivanti dalla
garanzia di due anni fornita dal venditore in caso di non conformita dei beni rispetto al contratto di vendita.
Tuttavia, diversi fattori possono avere un impatto sulla possibilita’ di beneficiare di tali diritti. | diritti spettanti
ai consumatori in forza della garanzia legale non sono in alcun modo limitati, né modificati dalla Garanzia
limitata HP. Per ulteriori informazioni, si prega di consultare il seguente link: Garanzia legale per i clienti
(www.hp.com/go/eu-legal), oppure visitare il sito Web dei Centri europei per i consumatori
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). |
consumatori hanno il diritto di scegliere se richiedere un servizio usufruendo della Garanzia limitata HP
oppure rivolgendosi al venditore per far valere la garanzia legale di due anni.

Spain

Su Garantia limitada de HP es una garantia comercial voluntariamente proporcionada por HP. El nombre y
direccion de las entidades HP que proporcionan la Garantia limitada de HP (garantia comercial adicional del
fabricante) en su pais es:

Espaiia: Hewlett-Packard Espaiiola S.L. Calle Vicente Aleixandre, 1 Parque Empresarial Madrid - Las Rozas,
E-28232 Madrid

Los beneficios de la Garantia limitada de HP son adicionales a la garantia legal de 2 afios a la que los
consumidores tienen derecho a recibir del vendedor en virtud del contrato de compraventa; sin embargo,
varios factores pueden afectar su derecho a recibir los beneficios bajo dicha garantia legal. A este respecto, la
Garantia limitada de HP no limita o afecta en modo alguno los derechos legales del consumidor
(www.hp.com/go/eu-legal). Para mas informacion, consulte el siguiente enlace: Garantia legal del
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consumidor o puede visitar el sitio web de los Centros europeos de los consumidores (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Los clientes tienen
derecho a elegir si reclaman un servicio acogiéndose a la Garantia limitada de HP o al vendedor de
conformidad con la garantia legal de dos afios.

Denmark

Norway

Den begransede HP-garanti er en garanti, der ydes frivilligt af HP. Navn og adresse pa det HP-selskab, der er
ansvarligt for HP's begraensede garanti i dit land, er som fglger:

Danmark: HP Inc Danmark ApS, Engholm Parkvej 8, 3450, Allergd

Den begraensede HP-garanti gaelder i tilleg til eventuelle juridiske rettigheder, for en toarig garanti fra
saelgeren af varer, der ikke er i overensstemmelse med salgsaftalen, men forskellige faktorer kan dog pavirke
din ret til at opna disse rettigheder. Forbrugerens lovbestemte rettigheder begraenses eller pavirkes ikke pa
nogen made af den begraensede HP-garanti. Se nedenstaende link for at fa yderligere oplysninger:
Forbrugerens juridiske garanti (www.hp.com/go/eu-legal) eller du kan besgge De Europaiske
Forbrugercentres websted (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Forbrugere har ret til at vaelge, om de vil ggre krav pa service i
henhold til HP's begraensede garanti eller hos szelger i henhold til en toarig juridisk garanti.

HPs garanti er en begrenset og kommersiell garanti som HP selv har valgt a tilby. Falgende lokale selskap
innestar for garantien:

Norge: HP Norge AS, Rolfbuktveien 4b, 1364 Fornebu

HPs garanti kommer i tillegg til det mangelsansvar HP har i henhold til norsk forbrukerkjgpslovgivning, hvor
reklamasjonsperioden kan vare to eller fem ar, avhengig av hvor lenge salgsgjenstanden var ment a vare.
Ulike faktorer kan imidlertid ha betydning for om du kvalifiserer til a kreve avhjelp iht slikt mangelsansvar.
Forbrukerens lovmessige rettigheter begrenses ikke av HPs garanti. Hvis du vil ha mer informasjon, kan du
klikke pa falgende kobling: Juridisk garanti for forbruker (www.hp.com/go/eu-legal) eller du kan besgke
nettstedet til de europeiske forbrukersentrene (http://ec.europa.eu/consumers/solving_consumer_disputes/
non-judicial_redress/ecc-net/index_en.htm). Forbrukere har retten til a velge a kreve service under HPs
garanti eller iht selgerens lovpalagte mangelsansvar.

Sweden

94

HP:s begransade garanti r en kommersiell garanti som tillhandahalls frivilligt av HP. Namn och adress till det
HP-foéretag som ansvarar for HP:s begransade garanti i ditt land ar som foljer:

Sverige: HP PPS Sverige AB, SE-169 73 Stockholm

Fordelarna som ingar i HP:s begrénsade garanti géller utéver de lagstadgade rattigheterna till tre ars garanti
fran saljaren angaende varans bristande dverensstammelse gentemot kopeavtalet, men olika faktorer kan
paverka din ratt att utnyttja dessa rattigheter. Konsumentens lagstadgade rattigheter varken begrdnsas eller
paverkas pa nagot satt av HP:s begransade garanti. Mer information far du om du fdljer denna lank:
Lagstadgad garanti for konsumenter (www.hp.com/go/eu-legal) eller sa kan du ga till European Consumer
Centers webbplats (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-
net/index_en.htm). Konsumenter har ratt att valja om de vill stélla krav enligt HP:s begransade garanti eller
pa saljaren enligt den lagstadgade treariga garantin.
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Portugal

A Garantia Limitada HP é uma garantia comercial fornecida voluntariamente pela HP. 0 nome e a morada da
entidade HP responsavel pela prestacdao da Garantia Limitada HP no seu pais sao os seguintes:

Portugal: HPCP — Computing and Printing Portugal, Unipessoal, Lda., Edificio D. Sancho I, Quinta da Fonte,
Porto Salvo, Lisboa, Oeiras, 2740 244

As vantagens da Garantia Limitada HP aplicam-se cumulativamente com quaisquer direitos decorrentes da
legislacdo aplicavel a garantia de dois anos do vendedor, relativa a defeitos do produto e constante do
contrato de venda. Existem, contudo, varios fatores que poderdo afetar a sua elegibilidade para beneficiar de
tais direitos. Os direitos legalmente atribuidos aos consumidores nao sao limitados ou afetados de forma
alguma pela Garantia Limitada HP. Para mais informacoes, consulte a ligacdo seguinte: Garantia legal do
consumidor (www.hp.com/go/eu-legal) ou visite o Web site da Rede dos Centros Europeus do Consumidor
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm).
Os consumidores tém o direito de escolher se pretendem reclamar assisténcia ao abrigo da Garantia Limitada
HP ou contra o vendedor ao abrigo de uma garantia juridica de dois anos.

Greece and Cyprus

H Neplopiopévn eyyunaon HP givol puo epmmoptkn eyyunaon n omoia mopéxetal eBeAoviika armd tnv HP. H
eNMwvupia Kot n tevBuvon tou voukoU mpoowtou HP mou mapéxel tnv Meplopiopévn eyyunon HP otn xwpa
oag eivar n €€AC:

EAA@da /Kimpog: HP Printing and Personal Systems Hellas EPE, Tzavella 1-3, 15232 Chalandri, Attiki

EAAada /Kimpoc: HP Zuotrfpota Ektunwong kot Mpoowmikwv YmoAoylotwv EAAGC Etapeia Neploplopévng
EuBuvng, Tzavella 1-3, 15232 Chalandri, Attiki

Ta mpovapa tng Meploplopévng eyyunong HP toxUouv emmA€ov Twv VOUIHWVY SIKaLWUETWV yiax dleth eyyinon
€vavtl tou MwAntA yio T pn GUHHOpGWon TwV MPOIOVTWY HE TIC GUVOHOAOYNHEVEC CUMBOTIKK LOLOTNTEC,
wWOoTO00 N &OKNGN TWV SIKKLWHATWY 00C XUTWV MTTOPEL var e€xpTdrTal armd diddopoug mapdyovte. Ta VOHLHX
OLKOILWHOTO TWV KATXVOXAWTWVY dev replopilovtal oUute ennpeddovtol Kad’ olovonmoTe TPomo aré tnv
Meplopiopévn eyyunon HP. lNa meploodtepeg mAnpodopiec, cupBouleuteite tnv akOAoubn tomoBeaoia web:
Nopwn eyyunon kotaveAwtr (www.hp.com/go/eu-legal) i propeite va emokedreite tnv tomobecio web twv
Eupwmaikwv Kévtpwv KatavaAwth (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Ot KATAVOAWTEC €XOUV TO diKaiwpa va emAEEoUV av Ba € lwoouy
TV utinpeoio ota mAaiowx tng Meploplopévng eyyunong HP i armé tov mwAntA ota MAKioLa TG VOULUNG
€yyunonc 600 eTwv.

Hungary

ENWW

A HP korlatozott jotallas egy olyan kereskedelmi jotallas, amelyet a HP a sajat elhatarozasabol biztosit. Az
egyes orszagokban a HP mint gyarto altal vallalt korlatozott jotallast biztosito HP vallalatok neve és cime:

Magyarorszag: HP Inc Magyarorszag Kft., H-1117 Budapest, Aliz utca 1.

A HP korlatozott jotallasban biztositott jogok azokon a jogokon feliil illetik meg Ont, amelyek a termékeknek
az adasvételi szerzddés szerinti mindségére vonatkozo kétéves, jogszabalyban foglalt eladdi szavatossagbol,
tovabba ha az On altal vasarolt termékre alkalmazandd, a jogszabalyban foglalt kitelezd eladoi jotallasbal
erednek, azonban szamos kériilmény hatassal lehet arra, hogy ezek a jogok Ont megilletik-e. Tovabbi
informacidért kérjiik, keresse fel a kdvetkezd webhelyet: Jogi Tajékoztato Fogyasztéknak
(www.hp.com/go/eu-legal) vagy latogassa meg az Eurdpai Fogyasztdi Kozpontok webhelyét
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). A
fogyasztéknak jogaban all, hogy megvalasszak, hogy a jotallassal kapcsolatos igényiiket a HP korlatozott
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jotallas alapjan vagy a kétéves, jogszabalyban foglalt eladoi szavatossag, illetve, ha alkalmazando, a
jogszabalyban foglalt kotelezé eladdi jétallas alapjan érvényesitik.

Czech Republic

Omezena zaruka HP je obchodni zarukou dobrovolné poskytovanou spolec¢nosti HP. Nazvy a adresy
spolecnosti skupiny HP, které odpovidaji za plnéni omezené zaruky HP ve vasi zemi, jsou nasledujici:

€eska republika: HP Inc Czech Republic s. r. 0., Za Brumlovkou 5/1559, 140 00 Praha 4

Vyhody, poskytované omezenou zarukou HP, se uplatriuji jako doplriek k jakymkoli pravnim narokim na
dvouletou zaruku poskytnutou prodejcem v pfipadé nesouladu zbozi s kupni smlouvou. Vas narok na uznani
téchto prav vsak mize zaviset na mnohych faktorech. Omezena zaruka HP zadnym zplsobem neomezuje ani
neovliviiuje zakonna prava zakaznika. DalSi informace ziskate kliknutim na nasledujici odkaz: Zakonna zaruka
spotrebitele (www.hp.com/go/eu-legal) pfipadné miiZete navstivit webové stranky Evropského
spotiebitelského centra (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/
ecc-net/index_en.htm). Spotiebitelé maji pravo se rozhodnout, zda chtéji sluzbu reklamovat v ramci omezené
zaruky HP nebo v ramci zakonem stanovené dvouleté zaruky u prodejce.

Slovakia

Obmedzena zaruka HP je obchodna zaruka, ktort spolo¢nost HP poskytuje dobrovolne. Meno a adresa
subjektu HP, ktory zabezpecuje plnenie vyplyvajuce z Obmedzenej zaruky HP vo vasej krajine:

Slovenska republika: HP Inc Slovakia, s.r.o., Galvaniho 7, 821 04 Bratislava

Vyhody Obmedzenej zaruky HP sa uplatnia vedla pripadnych zakaznikovych zakonnych narokov voci
predavajlcemu z vad, ktoré spocivaju v nesulade vlastnosti tovaru s jeho popisom podla predmetnej zmluvy.
Moznost uplatnenia takych pripadnych narokov viak moéze zavisiet od réznych faktorov. Sluzby Obmedzenej
zaruky HP ziadnym sp6sobom neobmedzujl ani neovplyviuju zakonné prava zakaznika, ktory je
spotrebitelom. Dalsie informacie najdete na nasledujtiicom prepojeni: Zakonna zaruka spotrebitela
(www.hp.com/go/eu-legal), pripadne mdzete navstivit webovu lokalitu eurdpskych zakaznickych stredisk
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm).
Spotrebitelia maju pravo zvolit si, ¢i chct uplatnit servis v ramci Obmedzenej zaruky HP alebo pocas zakonnej
dvojrocnej zarucnej lehoty u predajcu.

Ograniczona gwarancja HP to komercyjna gwarancja udzielona dobrowolnie przez HP. Nazwa i adres
podmiotu HP odpowiedzialnego za realizacje Ograniczonej gwarancji HP w Polsce:

Polska: HP Inc Polska sp. z 0.0., Szturmowa 2a, 02-678 Warszawa, wpisana do rejestru przedsiebiorcow
prowadzonego przez Sad Rejonowy dla m.st. Warszawy w Warszawie, XIll Wydziat Gospodarczy Krajowego
Rejestru Sadowego, pod numerem KRS 0000546115, NIP 5213690563, REGON 360916326, GI0S
E0020757WZBW, kapitat zaktadowy 480.000 PLN.

Swiadczenia wynikajace z Ograniczonej gwarancji HP stanowia dodatek do praw przystugujacych nabywcy w
zwigzku z dwuletnig odpowiedzialnoscig sprzedawcy z tytutu niezgodnosci towaru z umowa (rekojmia).
Niemniej, na mozliwos¢ korzystania z tych praw majg wptyw rézne czynniki. Ograniczona gwarancja HP w
zaden sposAb nie ogranicza praw konsumenta ani na nie nie wptywa. Wiecej informacji mozna znalez¢ pod
nastepujgcym taczem: Gwarancja prawna konsumenta (www.hp.com/go/eu-legal), mozna takze odwiedzi¢
strone internetowg Europejskiego Centrum Konsumenckiego (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Konsumenci maja prawo wyboru co
do mozliwosci skorzystania albo z ustug gwarancyjnych przystugujgcych w ramach Ograniczonej gwarancji HP
albo z uprawnien wynikajgcych z dwuletniej rekojmi w stosunku do sprzedawcy.
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Bulgaria

OrpaHuyeHaTa rapaHuus Ha HP npeacrtaBnsaea TbproBcka rapaHums, 4o6poBonHO npefgocTassaHa ot HP.
MmeTo 1 agpecbT Ha Apy>ecTBoTO Ha HP 3a BawaTa cTpaHa, 0TrOBOPHO 3a NPeA0CTaBAHETO Ha
rapaHuMOHHaTa NoAAPbXKa B paMmkuTe Ha OrpaHuMyeHaTa rapaHuma Ha HP, ca kakTo cnepga:

HP Inc Bulgaria EOOD (Eiu My UHK Bbnrapua EOOQ), rp. Codua 1766, paitoH p-H Mnapocr, 6yn.
OkonoBpbcTeH MbT No 258, busHec LleHTbp KambaHute

MpeaumcTeaTa Ha OrpaHnyeHaTa rapaHuma Ha HP ce npunarat B 4onb/IHEHWE KbM BCMYKW 3aKOHOBM MpaBa 3a
[BYrooMLLIHA rapaHLmMa OT NpoAaBaya Npy HeCbOTBETCTBME Ha CTOKAaTa C JoroBopa 3a npojax6ba. Bbnpeku
TOBa, Pa3/IMYHM HAKTOPM MOraT [a OKaXaT BNMUAHKWE BbPXY YCNOBUATA 3a NONyYaBaHe Ha Te3u npasa.
3aKoHOBMTE NpaBa Ha NOTPe6MTeNMTe He Ca OrpaHMYEeHM MK 3aCerHaTh No HUKaKbB HaunH oT OrpaHuyeHaTa
rapaHuus Ha HP. 3a nonbnHutenHa nipopmaumsa, Mmona Buxre lNpaBHaTa rapaHUuMsa Ha noTpebuTtens
(www.hp.com/go/eu-legal) nnu noceteTe ye6bcaita Ha EBponeiickna noTpebuTencku LeHTbP
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm).
MoTpe6buTenuTe MMAT NPaBOTO A4a M36MpPAT Aanu Aa npeTeHAUpaT 3a M3BbpLUBAHe Ha ycnyra B paMK1TE Ha
OrpaHuueHaTa rapaHuums Ha HP unu oa noTbpcAaT TakaBa OT TbpProseLa B paMKUTe Ha ABYroJuvLLIHaTa NpaBHa
rapaHuus.

Romania

Garantia limitata HP este o garantie comerciala furnizata in mod voluntar de catre HP. Numele si adresa
entitatii HP raspunzatoare de punerea in aplicare a Garantiei limitate HP in tara dumneavoastra sunt
urmatoarele:

Romania: HP Inc Romania SRL, 5 Fabrica de Glucoza Str., Building F, Ground Floor & Floor 8, 2nd District,
Bucuresti

Beneficiile Garantiei limitate HP se aplica suplimentar fata de orice drepturi privind garantia de doi ani oferita
de vanzator pentru neconformitatea bunurilor cu contractul de vanzare; cu toate acestea, diversi factori pot
avea impact asupra eligibilitatii dvs. de a beneficia de aceste drepturi. Drepturile legale ale consumatorului nu
sunt limitate sau afectate in vreun fel de Garantia limitata HP. Pentru informatii suplimentare consultati
urmatorul link: garantia acordata consumatorului prin lege (www.hp.com/go/eu-legal) sau puteti accesa site-
ul Centrul European al Consumatorilor (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Consumatorii au dreptul sa aleaga daca sa pretinda despagubiri in
cadrul Garantei limitate HP sau de la vanzator, in cadrul garantiei legale de doi ani.

Belgium and the Netherlands

ENWW

De Beperkte Garantie van HP is een commerciéle garantie vrijwillig verstrekt door HP. De naam en het adres
van de HP-entiteit die verantwoordelijk is voor het uitvoeren van de Beperkte Garantie van HP in uw land is
als volgt:

Nederland: HP Nederland B.V., Startbaan 16, 1187 XR Amstelveen
Belgié: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

De voordelen van de Beperkte Garantie van HP vormen een aanvulling op de wettelijke garantie voor
consumenten gedurende twee jaren na de levering te verlenen door de verkoper bij een gebrek aan
conformiteit van de goederen met de relevante verkoopsovereenkomst. Niettemin kunnen diverse factoren
een impact hebben op uw eventuele aanspraak op deze wettelijke rechten. De wettelijke rechten van de
consument worden op geen enkele wijze beperkt of beinvloed door de Beperkte Garantie van HP. Raadpleeg
voor meer informatie de volgende webpagina: Wettelijke garantie van de consument (www.hp.com/go/eu-
legal) of u kan de website van het Europees Consumenten Centrum bezoeken (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumenten hebben
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het recht om te kiezen tussen enerzijds de Beperkte Garantie van HP of anderzijds het aanspreken van de
verkoper in toepassing van de wettelijke garantie.

Finland

HP:n rajoitettu takuu on HP:n vapaaehtoisesti antama kaupallinen takuu. HP:n mydntamasta takuusta
maassanne vastaavan HP:n edustajan yhteystiedot ovat:

Suomi: HP Finland Oy, Piispankalliontie, FIN - 02200 Espoo

HP:n takuun edut ovat voimassa mahdollisten kuluttajansuojalakiin perustuvien oikeuksien lisdksi sen
varalta, ettd tuote ei vastaa myyntisopimusta. Saat lisatietoja seuraavasta linkista: Kuluttajansuoja
(www.hp.com/go/eu-legal) tai voit kdyda Euroopan kuluttajakeskuksen sivustolla (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Kuluttajilla on oikeus
vaatia virheen korjausta HP:n takuun ja kuluttajansuojan perusteella HP:lta tai myyjalta.

Slovenia

Omejena garancija HP je prostovoljna trgovska garancija, ki jo zagotavlja podjetje HP. Ime in naslov poslovne
enote HP, ki je odgovorna za omejeno garancijo HP v vasi drzavi, sta naslednja:

Slovenija: Hewlett-Packard Europe B.V., Amsterdam, Meyrin Branch, Route du Nant-d'Avril 150, 1217 Meyrin,
Switzerland

Ugodnosti omejene garancije HP veljajo poleg zakonskih pravic, ki ob sklenitvi kupoprodajne pogodbe izhajajo
iz dveletne garancije prodajalca v primeru neskladnosti blaga, vendar lahko na izpolnjevanje pogojev za
uveljavitev pravic vplivajo razli¢ni dejavniki. Omejena garancija HP nikakor ne omejuje strankinih z zakonom
predpisanih pravic in ne vpliva nanje. Za dodatne informacije glejte naslednjo povezavo: Strankino pravno
jamstvo (www.hp.com/go/eu-legal); ali pa obis¢ite spletno mesto evropskih sredis¢ za potrosnike
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm).
Potrosniki imajo pravico izbrati, ali bodo uveljavljali pravice do storitev v skladu z omejeno garancijo HP ali
proti prodajalcu v skladu z dvoletno zakonsko garancijo.

Croatia

HP ograni¢eno jamstvo komercijalno je dobrovoljno jamstvo koje pruza HP. Ime i adresa HP subjekta
odgovornog za HP ograni¢eno jamstvo u vasoj drzavi:

Hrvatska: HP Computing and Printing d.o.0. za ra¢unalne i srodne aktivnosti, Radnicka cesta 41, 10000
Zagreb

Pogodnosti HP ograni¢enog jamstva vrijede zajedno uz sva zakonska prava na dvogodisnje jamstvo kod bilo
kojeg prodavaca s obzirom na nepodudaranje robe s ugovorom o kupnji. Medutim, razni faktori mogu utjecati
na vasu mogucénost ostvarivanja tih prava. HP ograni¢eno jamstvo ni na koji nacin ne utjece niti ne ograni¢ava
zakonska prava potrosaca. Dodatne informacije potrazite na ovoj adresi: Zakonsko jamstvo za potrosace
(www.hp.com/go/eu-legal) ili moZete posjetiti web-mjesto Europskih potrosackih centara
(http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm).
Potros$aci imaju pravo odabrati Zele li ostvariti svoja potrazivanja u sklopu HP ograni¢enog jamstvaili pravnog
jamstva prodavaca u trajanju ispod dvije godine.

Latvia

HP ierobeZota garantija ir komercgarantija, kuru brivpratigi nodroSina HP. HP uznémumes, kas sniedz HP
ierobezotas garantijas servisa nodroSinajumu jisu valsti:

Latvija: HP Finland Oy, PO Box 515, 02201 Espoo, Finland
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HP ierobeZotas garantijas priekSrocibas tiek piedavatas papildus jebkuram likumigajam tiesibam uz
pardevéja un/vai razotaju nodrosinatu divu gadu garantiju gadijuma, ja preces neatbilst pirkuma ligumam,
tomeér 5o tiesibu sanemsanu var ietekmét vairaki faktori. HP ierobezota garantija nekada veida neierobezo un
neietekmé patéréetaju likumigas tiesibas. Lai iegutu plasaku informaciju, izmantojiet So saiti: Patérétaju
likumiga garantija (www.hp.com/go/eu-legal) vai ar Eiropas Patérétaju tiesibu aizsardzibas centra timekla
vietni (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/
index_en.htm). Patérétajiem ir tiesibas izvéléties, vai pieprasit servisa nodrosinajumu saskana ar HP
ierobezoto garantiju, vai ari pardevéja sniegto divu gadu garantiju.

Lithuania

HP ribotoji garantija yra HP savanoriskai teikiama komerciné garantija. Toliau pateikiami HP bendroviy,
teikianciy HP garantijg (gamintojo garantijg) jasy Salyje, pavadinimai ir adresai:

Lietuva: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP ribotoji garantija papildomai taikoma kartu su bet kokiomis kitomis jstatymais nustatytomis teisémis j
pardavéjo suteikiama dviejy mety laikotarpio garantijg dél prekiy atitikties pardavimo sutardiai, taciau tai, ar
jums Si teisé bus suteikiama, gali priklausyti nuo jvairiy aplinkybiy. HP ribotoji garantija niekaip neapriboja ir
nejtakoja jstatymais nustatyty vartotojo teisiy. Daugiau informacijos rasite paspaude Sig nuoroda: Teisiné
vartotojo garantija (www.hp.com/go/eu-legal) arba apsilanke Europos vartotojy centro internetinéje
svetainéje (http://ec.europa.eu/consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/
index_en.htm). Vartotojai turi teise prasyti atlikti techninj aptarnavima pagal HP ribotaja garantijg arba
pardavéjo teikiama dviejy mety jstatymais nustatytg garantija.

Estonia

HP piiratud garantii on HP poolt vabatahtlikult pakutav kaubanduslik garantii. HP piiratud garantii eest
vastutab HP liksus aadressil:

Eesti: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP piiratud garantii rakendub lisaks seaduses ettenahtud miiiijapoolsele kaheaastasele garantiile, juhul kui
toode ei vasta miiligilepingu tingimustele. Siiski vdib esineda asjaolusid, mille puhul teie jaoks need digused
ei pruugi kehtida. HP piiratud garantii ei piira ega mdjuta mingil moel tarbija seadusjargseid digusi. Lisateavet
leiate jargmiselt lingilt: tarbija diguslik garantii (www.hp.com/go/eu-legal) vai vdite kiilastada Euroopa
tarbijakeskuste veebisaiti (http://ec.europa.eu/consumers/solving _consumer_disputes/non-judicial_redress/
ecc-net/index_en.htm). Tarbijal on Gigus valida, kas ta soovib kasutada HP piiratud garantiid voi seadusega
ette nahtud miilijapoolset kaheaastast garantiid.

Russia
Cpok cnyXx6b1 npuHTepa ana Poccuun

Cpok cny>x6bl gaHHoro npuHTepa HP coctaBnsaeT NaTb NeT B HOPMasbHbIX YCNOBUAX 3KcnnyaTauuun. Cpok
CNy>X6bl 0TCYMTLIBAETCS C MOMEHTA BBOAA NPMHTEPA B 3KCNyaTauuko. B KoHue cpoka cnyx6bl HP
peKoMeHyeT NoCeTUTb Be6-CalT Halle cnyX6bl noaaep>Xku no agpecy http://www.hp.com/support u/unu
CBA3aTbCA C aBTOPM30BaHHbIM NOCTaBLWLMKOM ycnyr HP ona nonyyeHns pekomeHaaumuin B OTHOLLEHUN
DanbHenwero 6e30MacHOro UCNosib30BaHUA NPUHTEpPA.
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Product specifications

° Print specifications

° Physical specifications

° Power consumption and electrical specifications

° Acoustic emission specifications

° Environmental specifications

Print specifications

For a list of supported print resolutions, visit the printer support website at HP Customer Support .

Physical specifications

Product dimensions (width x Operation dimensions (width x

Product depth x height) depth x height) Weight
HP PageWide 352dw 530x 401 x 380 mm (20.87 x 806 x 681 x 380 mm (31.73 x 16.4 kg (35.1 lb)
15.79 x 14.96 inches) 26.81 x 14.96 inches)

Power consumption and electrical specifications

A CAUTION: Power requirements are based on the country/region where the product is sold. Do not convert
operating voltages. This will damage the product and any such damage is not covered under the HP limited
warranty and service agreements.

Acoustic emission specifications

Operation LwAd-mono (B) LwAd-color (B)

Print 6.9 6.8

[% NOTE: HP recommends that the printer be located in a room in which no employee has a regular
workstation.

Environmental specifications

Operating Transporting
Temperature 15°to 30°C —40° to 60° C
(59°to 86° F) (-40° to 140°F)
Relative humidity 20 to 80% 90% or less (non-condensing)
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Operating Transporting

Altitude

0to 3048 m (0 to 10,000 ft)

Tilt

IMPORTANT: Use caution when moving the
product after you install the cartridges. Tilting
the product at an angle greater than 3 degrees
canresult in ink leakage.

[% NOTE: Values are subject to change.
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Environmental product stewardship program

° Protecting the environment

° Ozone production

° Power consumption

° European Union Commission Requlation 1275/2008

° Paper

° HP PageWide printing supplies

° Plastics

° Electronic hardware recycling

° Material restrictions

— General battery information

— Battery disposal in Taiwan

— (alifornia Perchlorate Material Notice

— EU Battery Directive

— Battery notice for Brazil

° Chemical substances

e  EPEAT

° Disposal of waste equipment by users

e  Toxic and hazardous substance table (China)

° Restriction on hazardous substances statement (Turkey)

° Restriction on hazardous substances statement (Ukraine)

° Restriction of hazardous substance statement (India)

° China energy label for printer, fax, and copier

° China SEPA Eco Label user information
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Protecting the environment

HP is committed to providing quality products in an environmentally sound manner. This product has been
designed with several attributes to minimize impacts on our environment.

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment to obtain more
information about HP and the environment, including environmental profile sheets for these products,
Material Data Safety Sheets, and HP return and recycling programs.

Ozone production

This product generates no appreciable ozone gas (0).

Power consumption

HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S.
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging
products:

ENERGY STAR

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar

European Union Commission Regulation 1275/2008

For product power data, including the power consumption of the product in networked standby if all wired
network ports are connected and all wireless network ports are activated, please refer to section P14
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Paper

This product is capable of using recycled paper and lightweight paper (EcoFFICIENT™) when the paper meets
the guidelines outlined in the product’s Print Media Guide. This product is suitable for the use of recycled
paper and lightweight paper (EcoFFICIENT™) according to EN12281:2002.

HP PageWide printing supplies

Original HP Supplies were designed with the environment in mind. HP makes it easy to conserve resources
and paper when printing. And when you are done, we make it easy and free to recycle. Program availability
varies. For more information, visit www.hp.com/recycle. To participate in HP Planet Partners return and
recycling program, visit www.hp.com/recycle. Select your country/region for information on how to return
your HP PageWide printing supplies.

[’-_%f? NOTE: Visit the HP sustainability website for complete recycling information and to order postage-paid
labels, envelopes, or boxes, for recycling.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.
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Electronic hardware recycling

HP encourages customers to recycle used electronic hardware. For more information about recycling
programes, visit the HP sustainability website.

Material restrictions

° General battery information

° Battery disposal in Taiwan

° California Perchlorate Mater

ial Notice

° EU Battery Directive

° Battery notice for Brazil

General battery information

This HP product does not contain intentionally added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries contained

in or supplied by HP for this product include the following.

HP PageWide 352dw

Type Lithium Manganese Dioxide
Weight 3.0g
Location On main board

User-removable

No

Battery disposal in Taiwan

CQ mmemEK

u Please recycle waste

batteries.

California Perchlorate Material Notice

California Perchlorate Material Neotice

Perchlorate material - spedial handling may apply. Ses:
hitp:  wewrer ditse. ca.gov/hozardouswaste, perchlorate/

This products realtime clock battery or cain cell batery may contain perchlarate and
may require special handling when recycled or disposed of in Calilomia.

EU Battery Directive

ENWW

This product contains a battery that is used to maintain data integrity of real time clock or product settings
and is designed to last the life of the product. Any attempt to service or replace this battery should be
performed by a qualified service technician.
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Battery notice for Brazil

A bateria deste equipamento ndo foi projetada para ser removida pelo cliente.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European
Parliament and the Council). A chemical information report for this product can be found at
http://www.hp.com/go/reach.

EPEAT

Most HP products are designed to meet EPEAT. EPEAT is a comprehensive environmental rating that helps
identify greener electronics equipment. For more information on EPEAT go to www.epeat.net. For information
on HP's EPEAT registered products go to www.hp.com/hpinfo/globalcitizenship/environment/pdf/
epeat_printers.pdf.

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, you should
protect human health and the environment by handing over your waste equipment to a designated collection
point for the recycling of waste electrical and electronic equipment. For more information, go to http://
www.hp.com/recycle
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Toxic and hazardous substance table (China)
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Restriction on hazardous substances statement (Turkey)

Tiirkiye Cumhuriyeti: EEE Yonetmeligine Uygundur

Restriction on hazardous substances statement (Ukraine)
06na.EI,HaHHH Bi,D,I'IOBi.EI.aE BMMOram TexHi4yHoro pernameHTy wono 06MeXeHHS BUKOPUCTAHHA OeAKUX

Hebe3neyHUx pevoBUH B eNIeKTPMYHOMY Ta e/IeKTPOHHOMY 06/1aAHAHHI, 3aTBEpAXKEHOr0 NOCTaHOBOH
Kab6iHeTy MiHicTpis Ykpainu Big, 3 rpyaHa 2008 N2 1057

Restriction of hazardous substance statement (India)

Restriction of hazardous substances [India)

This product lies with the "Indic E-waste (Manogement and Handling) Rule 2011" and
prohibits use lead, mercury, hexavalent chromium, poldbrominated biphenyls or
polybrominated diphemyl ethers in concentrations exceading 0.1 weight % and 0.01 weight
% for cadmium, except for the exemptions sst in Schedule 2 of the Rule.
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China energy label for printer, fax, and copier
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China SEPA Eco Label user information
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Regulatory information

° Regulatory notices

e  V(CC statement (Japan)

° Power cord instructions

° Power cord statement (Japan)

e  EMCstatement (Korea)

° Visual display workplaces statement for Germany

° European Union Regulatory Notice

° Additional statements for wireless products

Regulatory notices

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. This regulatory
number should not be confused with the marketing name or product numbers.

Product model number Regulatory Model Number
PageWide 352dw VCVRA-1501-01
PageWide 352dw VCVRA-1501-02

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

e  Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.
° Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

e  Consult the dealer or an experienced radio/TV technician for help.

[% NOTE: Any changes or modifications made to this device that are not expressly approved by HP may void
the user's authority to operate the equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

For further information, contact: Manager of Corporate Product Regulations, HP Inc., 1501 Page Mill Road,
Palo Alto, CA 94304, USA.
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This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

VCCI statement (Japan)

COERRE., THRCERERSEIEE S S ANENE (Voo i) ol
EERI{LFABMEENER YT, cOoRRE. RERETERTECL
EABLLTLETY, CORENSOFSFLE S L RERICERLT
EHENEE, RERNEES SR TYoLMBYET.,

EERARCE TELLRYBVELTFEN,

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the product

label. The product uses either 100-240 Vac or 200-240 Vac and 50/60 Hz.

A CAUTION: To prevent damage to the product, use only the power cord that is provided with the product.

Power cord statement (Japan)
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EMC statement (Korea)
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Visual display workplaces statement for Germany

Das Gerét ist nicht fir die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen.
Um strende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren
Gesichtsfeld platziert warden.
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European Union Regulatory Notice

° European Union Requlatory Notice

° Wireless models only

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC,
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

HP GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

Wireless models only
EMF
e  This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.

If it incorporates a radio transmitting and receiving device that in normal use, a separation distance of
20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

e  This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein,
Norway and Switzerland.
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Additional statements for wireless products

Exposure to radio frequency radiation

Notice to users in Brazil

Canadian statements

Japan statement

Notice to users in Korea

Taiwan statement

Mexico statement

Exposure to radio frequency radiation

Exposvure to radlo frequency radlation

Coution Theo rodiated cudput powor of thiz devizo iz far bolow the FOC radie
frequency exposure limits. MNeverthaless, the device shall be uzed in such o manner
thot the potensial for human contoct during normal operation is minimized. This
product and any atleched exdemal arfenna, if supporled. shall be placed in such
@ mannat bo minimao the potontial for human conlact during narmal oporation. In
order o avoid tho possibiity of oxcosding the FOC rodio frequency exposure
limits, human prosimity to the anfenna shall nod be less than 20 em (8 inches)
during normal eperation.

Notice to users in Brazil

Aviso aos usuarios no Brasil

Este equipamentc opera em cardter secunddrio, isto &, nio tem direito & proteco confra
interferéncia prejudicial, mesmo de estacdes do mesme tipe, e ndo pode cousar inferferén-

cia a sistemas operando em cardter primario.

Canadian statements

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and

maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio
interference to other users, the antenna type and its gain should be so chosen that the equivalent
isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the

following two conditions: (1) this device may not cause interference, and (2) this device must accept any

interference, including interference that may cause undesired operation of the device.

A WARNING! Exposure to Radio Frequency Radiation The radiated output power of this device is below the
Industry Canada radio frequency exposure limits. Nevertheless, the device should be used in such a manner
that the potential for human contact is minimized during normal operation.

To avoid the possibility of exceeding the Industry Canada radio frequency exposure limits, human proximity
to the antennas should not be less than 20 cm (8 inches).
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Japan statement
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Notice to users in Korea
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Taiwan statement
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Mexico statement
Aviso para los usuarios de México

La operacidn de este equipo esta sujeta a las siguientes dos condiciones: (1) es posible que este equipo o
dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier
interferencia, incluyendo la que pueda causar su operacion no deseada. Para saber el modelo de la tarjeta
inaldmbrica utilizada, revise la etiqueta regulatoria de la impresora.
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